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O
ur Association’s two founding 

bodies, CIMA and the AICPA, 

epitomise long-lasting 

successful organisations. 

The AICPA was established 

in 1887, and CIMA marks its centenary 

this year. CIMA was founded by a group of 

forward-looking businesspeople. Its �rst 

president was Lord Leverhulme, then 

chairman of what is now Unilever, and 

early vice-presidents represented key 

industry segments including steelmaking, 

cotton spinning, car manufacturing, and 

printing. Their intention was to transform 

the accountancy profession into one that 

would support them in managing and 

leading their businesses.

CIMA’s initial work was around cost 

management: The period up to the late 

1930s can be described as the 

development of costing as a science. It 

culminated in the publishing in March 

1937 of “Costing Terminology” in The Cost 

Accountant, the Institute’s journal. 

Over the century CIMA has continued to 

lead on cost management and evolve it into 

the concept of value creation. The journey 

has taken us through cycles of automation, 

the evolution of risk management, tools 

such as balanced scorecards, and 

frameworks such as activity-based costing. 

CIMA’s history is contained in Leading the 

Transformation — 100 Years and Beyond, 

written by the Association’s Martin Farrar, 

Ph.D., which I commend to you (available at 

tinyurl.com/yymzsnrq).

Learning 

from the past

We have pinpointed the �rst use of the 

term “management accountancy” in this 

journal to October 1950, when it 

announced that a team was to visit the US 

to investigate the use of costing 

information through the Anglo-American 

Productivity Council.

Today, management accounting is 

recognised as the essential part of 

“decision support”, and management 

accountants work alongside business 

leaders and managers as trusted and 

objective partners.

Over the years, we have added value to 

business. We have also provided 

opportunities for people across the world 

to have rewarding and satisfying careers. 

Our members have made a di�erence not 

only to the businesses they work for but 

also the communities they live in.

Today, CIMA and the AICPA continue to 

lead in the accounting profession. As the 

founding bodies of the Association of 

International Certi�ed Professional 

Accountants, we are driving a global 

management accounting profession, 

creating value for businesses and the 

proud individuals who make up our 

profession.

Both sides of the profession — 

management and public accounting — 

anticipate change on a scale and at a 

speed we have not experienced before. 

However, with our updated CGMA 

Competency Framework, the Finance 

Leadership Program, and our growing 

suite of CPE programmes, we are 

equipping our members to thrive in that 

digital future.

As work becomes increasingly 

technology-enabled, I believe the 

management accountant’s role will 

become even more critical to the success 

and longevity of organisations. That role 

is increasingly about asking the right 

questions that can lead to better  

decision-making. Canadian historian 

Margaret MacMillan neatly makes the 

case for learning from the past. “History 

can help you … to make sense of your 

present situation; to remind you that 

there were other situations like it in the 

past; and to help you formulate the right 

questions.” I believe learning from past 

experience can prepare you to bring order 

quickly when faced with the ever more 

complex scenarios that accelerating 

change in business brings.

The Association will continue to ask 

the right questions and continue to invest 

in our ability to provide learning for our 

members that is relevant and high-quality 

so that in turn they can continue to lead 

their organisations to greater success.   

By Andrew Harding, FCMA, CGMA
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Andrew Harding, FCMA, CGMA,  

is chief executive—Management 

Accounting, at the Association of 

International Certified Professional 

Accountants.
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    Keeping the seas 

shipshape



O
n 8 June, people around the globe will hold events celebrating 

the annual World Oceans Day, which is organised by US-based 

The Ocean Project. Whether they live on the coast or in the 

middle of a continent, management accountants can play a 

key role in developing sustainability practices for businesses, 

including those that use the oceans as thoroughfares for trade in the 

globalised economy. For more on sustainability-related accounting 

resources, visit tinyurl.com/y6e7u9tz.

Cargo ships navigate the North Sea as seen 
from the beach at Dishoek in the Netherlands.



INFO ROUNDUP

What China is 

doing in Africa

Researchers at the China-Africa 

Research Initiative at Johns 

Hopkins School of Advanced 

International Studies argue in 

a policy brief that China’s 

rising labour cost and slowing 

growth are behind Chinese 

manufacturers’ move to shift 

production lines to Africa. 

They found four kinds of 

Chinese companies in Africa:

Companies seeking raw 

materials. Raw minerals 

usually are exported to 

wealthier countries for 

smelting and re�ning. 

Companies with global 

supply chains. Tanzania and 

Ethiopia are home to Chinese 

garment and shoe 

manufacturers. These 

labour-intensive industries 

often o�shore production 

lines. 

Companies seeking 

strategic local markets.  

For example, a Chinese 

agrochemical producer 

purchased a Ghanaian 

company to expand its African 

sales channels.

Opportunistic small 

companies �ocking 

together. These are small-scale 

manufacturers clustering in an 

industrial zone. 

Australia finance job 
vacancies, 
salaries 
on the 
rise
In the face of �nance systems automation and 

o�shoring and outsourcing trends, demand is 

rising for quality �nance and accounting 

workers who can provide value-added services 

to �nance teams and direct �nance 

transformation in Australia, according to a 

recent report by recruitment �rm Michael Page.

Australia Salary Benchmark 2019 revealed 

that the past year has seen a 21% increase in the 

number of �nance and accounting jobs posted. 

Average salaries for these positions increased 

between 5% and 10% for workers who switch to 

a similar job. The top industries hiring for 

�nance and accounting roles include fast-

moving consumer goods and retail; healthcare 

and pharmaceutical; industrial and 

manufacturing; property and construction; and 

the public sector.

“Since the global �nancial crisis, there’s 

been a push for cost savings in Australia. We 

saw a number of �nance teams move their 

�nance functions — usually the more 

transactional teams — to di�erent parts of 

Asia,” said Sung Ho Lee, director of �nance, 

legal, and sales at Michael Page Australia.

To support the transformation of �nance 

functions, roles such as �nance project 

manager and head of transformation are in high 

demand, with an average salary of  

AUD 160,000 ($114,000) and AUD 205,000 

($146,000), respectively, according to the report.

Automation and o�shoring are also 

changing employers’ expectations. Companies 

in Australia now expect �nance workers to 

perform more higher-level work than before, 

such as providing decision-making analysis in 

addition to traditional �nancial reporting tasks. 

Trending skills in job descriptions re�ect this. 

Buzzwords include business partnering, big 

data, and analytics skills.

“The biggest challenge for �nance 

professionals is the growing need for digital 

and technical skills, and the need for swift 

adaptation to the rapidly changing �nance 

roles,” said Devika Mohotti, CPA (Australia), 

FCMA, CGMA, national sales operations 

manager at Schneider Electric in Sydney. 

“While some roles disappear, new roles 

continue to emerge and evolve. Unlearning is 

also an essential skill to adapt to [the] changing 

environment.”

— By Alexis See Tho (Alexis.SeeTho@ 

aicpa-cima.com), an FM magazine associate 

editor.
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230,000
People who paid the €9 

entrance fee to ascend to the 
viewing platform of 

thyssenkrupp’s 246-metre 
tower in the first 12 months 

after it was built.

Full story, page 42

Just fix it
‘If you have a problem now,  

why don’t you fix it now?’ 

— Paul Polman, chair of the International 

Chamber of Commerce and former CEO of 

Unilever, said on the lack of equal pay  

for men and women.

Full story, page 28

1.3 

million 
The approximate 
number of annual 
individual patient 

contacts at Nottingham 
University Hospitals in 

the UK.

Full story, page 22

PepsiCo Indonesia CFO: 

How I drive the 
business 
While well known for its soft drinks, PepsiCo is more than a 

beverage company. It also owns the Frito-Lay and Quaker Oats 

brands. In 2017, it was the third-largest food and beverage 

company in the world with global sales of $96.5 billion, behind 

Nestlé and the Coca-Cola Company.

Seven years ago, Dhianendra Laksmana, ACMA, CGMA, said 

yes to an opportunity of a lifetime to head the �nance function 

of PepsiCo Indonesia as its CFO. Laksmana shared 

with FM magazine how he drives PepsiCo Indonesia’s 

businesses. Edited excerpts follow.  

You’ve been a �nance manager and head of �nance before 

becoming a CFO. What is a key di�erence you see in your 

role as CFO?

I think the main di�erence is that a CFO is more than just a 

�nance head — you are expected to drive the business. 

Obviously, you ensure the delivery of �nancials, but the bigger 

objective is to work with the CEO to drive the business, drive 

performance. One goal that perfectly summed [up] the CFO’s role 

was [what] my boss told me when I �rst came and took on the 

role. He said, “Your objective is to try to replace me. Think like 

me and help me drive this business.”

For instance, I’m the one in charge of pro�t and loss 

forecasting. But forecasting will only be on paper. Any �nance 

manager can do forecasting, but driving the business is making 

sure that the forecasted commitment is being carried through.

Can you give an example of delivering the forecasted 

numbers?

We have monthly rolling forecasts. First, what we do is bottom 

up — get the input from sales and marketing. In most cases, that 

is not what we will �nally submit because there may be 

top-down targets that need to be met, or the bottom-up targets 

are more than what we need to deliver. 

Then you have to go to the details line by line — how we can 

achieve this target? In the channels, I see where we can go, 

where we can push more. They might say it cannot be done. So I 

will look at the historical numbers and say, “You did this without 

any promotional campaign. Now if you need to do the same, 

what do you need, how much [revenue] can we add if I give you 

more money for promotions?” 

What is a challenge for your role?

We are responsible for overall Indonesia delivery. The main 

challenge is how to drive the business with the di�erent kinds of 

set-up. We have to work with the bottling partner, [but] we’re not 

the one who owns the sales team, we’re not the one who owns 

the manufacturing, and [bottlers] have their own goals. We have 

to align their goals with ours to get our objectives. 

— By Alexis See Tho (Alexis.SeeTho@aicpa-cima.com), 

an FM magazine associate editor.
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A shift from compliance to strategic 

duties requires accountants to 

communicate, not just calculate. 

By Ken Tysiac

A
s the demand increases for management 

accountants to move from compliance duties to 

strategic adviser roles, the main question they 

face is: Are they ready?

The accounting profession is undergoing a 

fundamental shift as artificial intelligence and data analytics 

tools are rapidly being developed to take on the compliance 

functions traditionally handled by accountants. The CGMA 

Future of Finance global research project is part of an 

ongoing effort to develop a comprehensive picture of the 

workforce of the future and the skills that accountants need 

to develop.  
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It has become clear that as technology 

takes over compliance tasks, some 

accountants in company �nance 

departments are being asked to interpret 

increasing amounts of data and provide 

strategic insights to help guide the 

business. They are managing processes 

and teams in addition to the traditional 

e�orts of tax, audit, and �nancial 

reporting. 

Sometimes, they may �nd it’s easier to 

report what the numbers are than it is to 

communicate what the numbers mean.

“It’s hard for any mind to go from that 

level of detail and complexity [required 

in compliance accounting] … to then be 

this inspired communicator who can 

simplify that complexity into a 

compelling, passionate argument,” said 

Gordon Barrie, FCMA, CGMA, a 

consultant and executive coach at Barrie 

Associates in London. “It’s asking a lot of 

somebody to learn all of that and then 

bust out of a cake with some great 

strategic insight. The reality is, they have 

to do that over the course of their career 

if they’re going to be successful.”

The accountant may be the smartest 

person in the room, but their 

understanding of the numbers doesn’t 

mean much if they can’t turn their 

knowledge into strategic action and 

process improvements. Ultimately, 

success depends on two factors:

yyy Skillfully interacting with people 

from the �nance team and other 

departments to �nd the best course 

of action and build momentum.

yyy Communicating the best course of 

action to leadership and the board 

in a way that will generate support 

for that action.

The power of collaboration

After leaving public accounting for a 

CFO role at Miller’s Ale House 

restaurants, Kate Grangard, CPA, CGMA, 

quickly learned the importance of 

getting buy-in and e�ectively 

communicating her message.

Now, as CFO and chief operating 

o�cer of Gehring Group, a consultant 

group specialising in employee group 

bene�ts and risk management services for 

public-sector clients in the US, Grangard 

says the whiteboard is her most useful 

tool. She uses it to share and debate ideas 

as she attempts to build consensus within 

the �nance team, the operations group, 

and the leadership team.

5 
tips for presenting to senior management  

or the board

When finance staffers are trying to cultivate support for a project or helping 
leadership understand the business, delivering information effectively to 
leadership or the board requires great care. Your chances of a successful 
presentation increase if you follow these tips:

1 Prepare.  
Your knowledge needs to be much deeper than the contents of the 
presentation. Anticipate possible questions and your answers to them. 
Rehearse your presentation — perhaps in front of colleagues. 

2 Consider the technology.  
Make sure you know how your technology will work in the room where the 
presentation is given, but also make sure you are prepared to continue 
presenting if your technology fails. 

3 Share.  
In advance of a meeting, provide your audience with slides, charts, graphs, 
or written material. You may even wish to meet with some audience 
members ahead of time so you can get feedback before the meeting.

4 Keep it simple.  
Pick only the most important, relevant data. 

5 Get feedback.  
Following the presentation, ask a mentor, peer, or member of the audience 
to evaluate your performance. 

Grangard operates as the facilitator 

and calls on all participants, using 

open-ended questions to draw out 

ideas. Participants often arrive at better 

strategies than Grangard could have 

imagined on her own. And because 

they all had a role in creating the 

strategy, they support it more 

passionately.

“I know if I give them an opportunity 

to discuss things and we take care of 

the really big things that are a concern 

or a big consideration, chances are 

we’re going to get buy-in from all levels, 

all departments,” she said. “And then … 

we bring it together to the CEO, or I 

bring it to the CEO. A well-collaborated 

idea allows for the delivery of a uni�ed 

message.”

For Martyn Herbert, ACMA, CGMA, a 

senior management accountant at 

assisted-living provider Lifeways Group 

in London, the key to getting support is 

developing a relationship with people 

‘You’ve got to basically sit down and 
have conversations and spend a lot 
of time listening to people …’
Gordon Barrie, FCMA, CGMA, a consultant and executive coach at Barrie Associates
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A look at the future of finance

New research from the Association provides a clear picture of what the finance 
function looks like in a digital world, as well as how finance will continue to 
evolve. Visit cimaglobal.com/future or cgma.org/reinventing-finance for  
more information.

Ken Tysiac is FM magazine’s editorial 

director. To comment on this article or 

to suggest an idea for another article, 

contact him at Kenneth.Tysiac@

aicpa-cima.com.

in all the other areas of the business. He 

believes it’s important to move beyond 

the numbers to understand the goals 

and challenges of people who are doing 

the actual work.

It may be more exciting for those in 

�nance roles to concentrate on 

managing up and communicating their 

strategic ideas to the leadership team. 

But the strategies are more e�ective 

when �nance personnel also manage 

down to �gure out how to best serve the 

rank-and-�le employees.

Understanding the needs on the 

factory �oor can make �nance more 

e�ective in the CEO’s o�ce and the 

boardroom. Because �nance touches 

every aspect of an organisation, 

accountants can advocate with senior 

management and the board on behalf 

of sta�-level employees.

Helping the sta� understand that 

�nance is there to help them is just as 

important for accountants as learning 

about the business, Herbert said.

He suggested that accountants 

communicate to sta�: “I’m here to help 

you use the money you have in the 

most e�ective way to do the best job 

that you can do, and that comes from 

you telling me what I’m here to do. 

Whatever the problem is, if you have a 

set budget or a way of working, how do 

I help you maximise the money you 

have available to you to do the best 

job?”

Managing up is also critically 

important, and Barrie advises that 

�nance sta� get the opportunity to do 

this as soon as they are competent and 

con�dent (see the sidebar, “5 Tips for 

Presenting to Senior Management or the 

Board”).

Barrie said �nance professionals 

often are certain that a speci�c course 

of action will be advantageous because 

they have a more comprehensive 

knowledge of the data than anybody 

else in the company. But they can’t 

succeed unless they realise that the 

only way to gain support for the proper 

course of action is to prompt others to 

advocate or at least back the strategy.

“You’ve got to basically sit down and 

have conversations and spend a lot of 

time listening to people and having 

dialogue and conversations like, ‘What 

do you think about this? What would 

you do? How would you sell this? What 

are your concerns?’” Barrie said.

Accountants or salespeople?

It’s not lost on many accountants that 

their job has become more like a sales 

position than they envisioned when they 

decided to practise accounting. They may 

believe they are not meant to be 

salespeople, yet they need to develop 

sales skills to succeed. This means 

treating colleagues and leadership as 

though they are customers and requires 

an understanding of people as well as the 

numbers.

“In today’s society with all these 

multiple generations that we have in our 

workforce, we have to speak to all the 

di�erent types of learners and all the 

di�erent types of people in order to 

become e�ectively that thing we’ve 

always looked at as the other side [of 

business] that we don’t do well, which is 

sales,” Grangard said.

The good news is that nobody is better 

prepared from a knowledge standpoint 

to speak in this way. By virtue of their 

understanding of data and involvement 

with all the areas of the business, 

accountants have a comprehensive 

understanding of their organisations that 

is unmatched.

To improve their collaborative 

abilities, experts suggest:

Exercising patience
“Learn how to position what it is you 

want,” Grangard said. “It’s OK to ask for 

things, but make sure you do it 

respectfully and make sure you’re willing 

to understand that everything doesn’t 

happen overnight.”

Learning the language of investors, 
executives, and the board
Taking note of the topics and language 

the CEO uses when communicating 

with investors or stakeholders can 

help accountants understand how to 

drive the agenda. “That’s where the real 

great connection comes between the 

board-level need and the �nance core 

capability,” Barrie said. “It’s making 

that connection at the relevant level 

and �ltering and basically shaping the 

data, information, and everything else 

they have to present to the board.”

Serving on a board
This is an opportunity for professional 

development outside of regular work 

hours. “A good board is like another 

mentorship opportunity,” Grangard 

said. “[You] will build on [skills] with 

other organisations that are dealing 

with problems. It’s being a part of 

something. It’s giving back to the 

community. It will really broaden your 

perspective, and also I think it breaks 

the shell that sometimes … we live in.”

Telling a story rather than just 
divulging numbers
“You have the ability to tell that story,” 

Herbert said. “You have the ability to 

walk the board or whoever your 

stakeholders are to a conclusion. And 

it’s about getting better at that, how 

you turn that number and take away 

the accounting from it and tell it as a 

story that resonates with your 

common stakeholders.”   Q
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The Name Manager can make spreadsheets easier to 

follow, but Excel modellers must know how — and, more 

importantly, when — to properly use the tool.  

By Liam Bastick, FCMA, CGMA
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Excel range names:

Effective uses for

a key tool



I
f you were to ask modelling 

professionals about the merits of 

using range names, you would �nd 

that opinion is strongly divided. In 

spreadsheets, range names can 

provide great value when used 

appropriately and sparingly because they 

can make formulas easier to read. In 

macros (not discussed here), they are 

vital. Overuse, on the other hand, can lead 

to end-user confusion.

Range names are names used to refer 

to cell references, formula results, or 

values. They are often used to avoid 

hard-coded values appearing in formulas 

and to make formulas clearer in general. 

They are stored in what is known as the 

Name Manager in Excel.

Users may create these names with the 

Name Box (circled in the screenshot 

“Excel Name Box”) drop-down menus 

and/or simply use the keyboard shortcut 

Ctrl+F3 in all versions of Excel, and then 

click on the New button in the Name 

Manager dialog box, as shown in the 

screenshot “Excel Name Manager”.

Clicking on New (shown in the 

screenshot “Excel Name Manager”) causes 

a further dialog box to appear, as shown in 

the screenshot “New Name Dialog Box”.

Scope

Note the second section (Scope) in the 

“New Name Dialog Box” screenshot. All 

names have a scope, either to a speci�c 

worksheet (also called the local worksheet 

level) or to the entire workbook (also 

called the global workbook level). The 

scope of a name is the location within 

which the name is recognised without 

quali�cation. 

For example, if you have de�ned a 

range name as “Pro�t” with its scope as 

Sheet1, rather than “Workbook”, then it 

will be recognised as “Pro�t” only in 

Sheet1 (ie, without quali�cation).

To use this local name in another 

worksheet, you must qualify it by 

preceding it with the localised worksheet 

name:

=Sheet1!Pro�t

If you have de�ned a name, such as 
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Excel Name Box

New Name dialog box

Excel Name Manager

I



“Cash�ow”, and its scope is the workbook, 

that name is recognised for all worksheets 

in that workbook (but not for any other 

workbook). If the scope was to a 

worksheet (say, Sheet1), then the range 

name would be “Sheet1!Cash�ow” 

instead. Therefore, workbook scope 

makes for clearer range names and avoids 

confusion.

A name must always be unique within 

its scope. Excel prevents you from 

de�ning a name that is not unique within 

its scope. However, you can use the same 

name with di�erent scopes. For example, 

you can de�ne a name, such as “Pro�t”, 

that is scoped to Sheet1, Sheet2, and 
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otherwise be confused as a cell reference; 

for example, “Day1”, as this is already a cell 

reference (many people have tried!).

There appears to be no limit to the 

number of names you can de�ne, but a 

name may contain no more than 255 

characters. Names can contain uppercase 

and lowercase letters, but Excel does not 

distinguish between uppercase and 

lowercase characters in names. For 

example, if you have created the global 

name “Pro�t” and then create another 

global name called “PROFIT” in the same 

workbook, the second name will be 

rejected, as names need to be unique, 

irrespective of capitalisation.

It is not a syntax issue, but I strongly 

recommend thought is given to adding 

pre�xes to range names. Regular readers 

will note that my list range names always 

begin with “LU_” where “LU” stands for 

“Look Up”. Similarly, I use “BC_” for “Base 

Cell” when working with the OFFSET 

function.

By using these pre�xes, I understand 

the purpose of the range name, and 

names with a common purpose are 

grouped together in a list. This is not to 

say all range names should contain a 

pre�x. “Tax_Rate”, for instance, makes 

sense on its own, and adding a pre�x 

would only detract from the name given, 

potentially confusing the end user.

Creating range names quickly

There is a nifty shortcut for creating range 

names using existing names. Consider the 

list shown in the screenshot “List 

Example”.

If you were to highlight cells N12:N18 

in the “List Example” screenshot and then 

use the shortcut Ctrl+Shift+F3 (or, 

alternatively, select Create from 

Selection in the De�ned Names 

grouping of the Formulas tab on the 

ribbon), you would see the dialog box 

shown in the screenshot “Create Names”. 

With the �rst box (Top row) checked, 

by clicking on OK the range N13:N18 (not 

N12:N18) will be named “Phonetic_

Alphabet” (ie, the underscore will be 

added automatically). Ranges across rows 

can be named in seconds similarly using 

Left column.

The reason this dialog box uses check 

boxes (rather than option buttons) is to 

allow users to select more than one at a 

time. Consider the following example, as 

shown in the two parts of the screenshot 

“Create Names Example”.

List example

Create Names

Create Names example

Example data table in Excel Create Names dialog box

Sheet3 in the same workbook. Although 

each name is the same, each name is 

unique within its scope. You might do this 

to ensure that a formula that uses the 

name “GrossPro�t”, for example, is always 

referencing the same cells at the local 

worksheet level.

You can even de�ne the same name, 

such as “Pro�t”, for the global workbook 

level, but again this scope is unique. In 

this case, there may be a name con�ict. To 

resolve this con�ict, Excel uses the name 

that is de�ned for the worksheet by 

default. The local worksheet level takes 

precedence over the global workbook 

level. This can be circumvented by adding 

a pre�x to the name, eg, renaming it 

“WorkbookFile_Pro�t” instead.

It is possible to override the local 

worksheet level for all worksheets in the 

workbook, except for the �rst worksheet. 

This will always use the local name if 

there is a name con�ict and cannot be 

overridden.

It is strongly recommended that you 

always try to create range names on a 

workbook-scope level only. Further, 

where possible, avoid using range names 

in (sections of) worksheets that will be 

copied to other worksheets or workbooks. 

You will confuse Excel, the end user, and 

most importantly, yourself!

Care with names

The name string must begin with a letter 

or underscore character. Remaining 

characters in the name can be letters, 

numbers, periods, and underscore 

characters. Spaces are not allowed, but 

two words can be joined with an 

underscore (_) or period (.). For example, 

to enter the name “Cash Flow” you should 

enter “Cash_Flow” or “Cash.Flow”.

You cannot use a name that could 
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Highlighting N31:R34, referring to 

“Example Data Table in Excel”, and using 

the keyboard shortcut Ctrl+Shift+F3 once 

more should generate the Create Names 

from Selection dialog box, as shown in 

the “Create Names Dialog Box” screenshot, 

with both Top row and Left column 

checked. This means that O32:O34 will be 

called “Jan”, O33:R33 will be called “COGS”, 

and so on. This would take considerably 

longer to perform manually.

This example also illustrates why 

spaces are illegal characters in range 

names (and should not be added to 

formulas either). Space is the intersect 

operator in Excel. If you were to type the 

following formula:

=Gross_Margin Feb,

Excel would return the value in cell P34 

(the intersection of the two ranges 

shown in the “Example Data Table in 

Excel” screenshot), ie, $4,183. This can 

be a powerful yet quick and simple 

analytical tool for key outputs — faster 

than VLOOKUP or INDEX MATCH.

Using range names quickly

One of the reasons I like using the 

Ctrl+F3 shortcut is that it is part of the F3 

Names family of shortcuts. We have just 

seen how Ctrl+Shift+F3 can be useful 

— and so can F3 on its own. 

Perhaps superseded by the fact that 

in Excel 2007 and later versions, Excel 

will now prompt as you type 

formulas, F3 has been very useful in 

the past as the Paste Name shortcut. 

For example, as you type a formula, 

you can refer to a range name by 

simply typing F3 to get the Paste 

Name dialog box, as shown in the 

screenshot “Paste Name Box”.

If you select one of the names and 

click OK, this will insert the range name. 

However, look closer at the dialog 

box. The Paste List button in the bottom 

left-hand corner, if depressed, will paste 

the list and their de�nitions into a 

preselected range of cells (ie, before you 

use the shortcut F3) in an Excel 

worksheet, which can be invaluable for 

model auditing purposes.

Sometimes, formulas have been 

written before the range name was 

created. In some circumstances, it is 

possible to apply these names 

retrospectively using Apply Names 

within the De�ne Names group of the 

Formulas tab (see the screenshot “Apply 

Names Selection”).

Note that the keyboard shortcut 

Alt+I+N+A will work in all versions of 

Excel. Selecting the required range 

names in the resulting dialog box  

will see formulas on the active 

worksheet(s) updated accordingly, as 

shown in the screenshot “Apply 

Names Box”.

 

Deleting range names

If I got paid just $1 for every time I have 

been asked how to delete range names, I 

would probably have retired by now. 

This was chie�y attributable to the 

Paste Name box

Apply Names box Excel 2003 delete range name 

path

Apply Names selection

counterintuitive menu in Excel 2003 

and earlier versions, shown in the 

screenshot “Excel 2003 Delete Range 

Name Path”. 

From the resulting dialog box, you 

would then select the range name 

(unfortunately, only one at a time could 

be selected) and hit Delete, as shown in 

the screenshot “Excel 2003 De�ne Name 

Box”.
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Excel 2007 and later versions make this 

much simpler. In this case, users are more 

likely to go to the Name Manager rather 

than the confusing Insert drop-down 

menu, as shown in the screenshot “Name 

Manager Delete Option”:

The other marked improvement is that 

multiple names may be deleted 

simultaneously by using the Ctrl or Shift 

keys to make multiple selections before 

hitting the Delete button.

 

Relative referencing

By default, range names are referenced 

absolutely (ie, they contain the $ sign so 

that references remain static). However, 

imagine a scenario where you are 

modelling revenue and you wish to grow 

the prior-period value by in�ation (already 

given a range name, say cell C3 on Sheet1). 

Simply click on any cell (eg, I will use D17 

arbitrarily), then de�ne the new range 

name as shown in the screenshot “New 

Name Example”.

Note the Refers to: entry. Cell C17 (the 

cell to the left of D17) has been chosen 

without the dollar signs. This is a relative 

reference. Once we click on OK, the range 

name “Prior_Period” will be de�ned as the 

cell immediately to the left of the active 

cell. We can then in�ate values easily by 

copying the formula

=Prior_Period*(1+In�ation)

across the row.

 

Other types of names

As I said earlier, names may also refer to 

functions, dates, and constants — the 

latter can be useful (eg, “Months_in_Year” 

is de�ned as 12) in order to avoid inserting 

hard code into a formula.

 

Word to the wise

This article discusses just the tip of the 

names iceberg. Experimenting can pay big 

dividends. The aim is not to go overboard, 

however, as a preponderance of names in 

a workbook may actually make formulas 

— and hence your model — more di�cult 

to follow.

Further, be careful if you name ranges 

that are then deleted. The range names 

will not be deleted (even though they will 

no longer appear in the Name Box). They 

will need to be deleted as described above 

in order to avoid potential errors in 

formulas, etc. It’s important to remember 

this as it has often been a cause of �le 

corruption or crashing in Excel.   Q

Excel 2003 Define Name box

Name Manager Delete option 

New Name example
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The UK’s National Health Service uses data to seek 

better patient outcomes while maximising efficiency.

By Rebecca McCaffry, FCMA, CGMA

O
ne hundred years after the founding of CIMA as the 

Institute of Cost and Works Accountants, the 

principles and practices used by cost accounting 

professionals at the UK’s National Health Service are 

very similar to those used in 1919 (see the sidebar 

“Cost Accounting Took Slow Route to Appreciation”). Although the 

cost accountant of 1919 might be confused by the technology used 

today, the tactics of the past have a prominent role at Nottingham 

University Hospitals (NUH), which provides services to more than 

6 million people across the city and the region beyond and is 

recognised as a leader in healthcare cost transformation. Leading 

the charge are operational director of �nance Duncan Orme and 

head of costing Scott Hodgson, ACMA, CGMA, both of whom are 

involved in healthcare costing on a national level.

Bringing value

to healthcare
using cost accounting
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A 2014 CIMA report, Building Clinical 

Engagement With Costing, found that 

costing was generally viewed by 

clinicians as a support function, with 

engagement between costing and clinical 

teams limited to business case 

development. In recent years, however, 

clinicians have begun to realise the 

importance of cost information for 

decision-making, and the pro�le of 

healthcare costing has seen signi�cant 

promotion. Attendance at the Healthcare 

Financial Management Association’s 

2018 Clinical Forum saw doctors 

outnumber cost accountants for the �rst 

time, and a growing number of clinicians 

are speaking about costing at national 

conferences, further raising awareness 

amongst their peers.

Changing the image of cost 

accounting

While the raised pro�le of costing is 

welcome, Orme sees a danger that the 

demand for experienced cost 

accountants is beginning to outstrip 

supply. He believes cost accounting’s 

image needs a makeover and that the 

way to achieve this is to highlight the 

importance of the cost accountant’s 

skillset to the wider healthcare system.

“One key motivation in our roles, 

both as practitioners and as 

in�uencers on the national scene, is to 

promote interest in how you can, 

e�ectively, become a member of a 

clinical team, working with the 

clinicians in a healthcare environment 

to improve the value and outcomes of 

healthcare,” he said.

Management accounting techniques 

that were once used in the factory 
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setting are now being used to develop 

patient insights and deliver better 

healthcare outcomes.

Datasets

Hodgson explained the impact that the 

growing volumes of data and information 

have had on his role. 

“The amount of data and information 

we have and the meetings we attend about 

the information has really evolved,” he 

said. “When we started PLICS [patient-level 

information and costing system] in 2010, 

we had two or three information feeds. 

We now have over 70 feeds pulled into the 

system, and so far we have delivered £20 

million of savings.”

NUH sees approximately 1.3 million 

individual patient contacts per year, the 

equivalent of 1.3 million product lines. 

The NHS system uses a national tari� 

payment approach to cost reimbursement 

for healthcare providers based on 

organisation-level average cost data. This 

means that for each patient contact, the 

team is able to create an individual 

income and expenditure account showing 

details of day-to-day care, with an average 

of 150 data items per subject. On any 

given day, sta� can see how money was 

spent on patient care.

Hodgson explained the process. “We 

work hard on our visual presentation of 

this for the clinicians, using red or green 

bed days to distinguish those days when 

no diagnostic or therapeutic activity has 

occurred. Clinical teams can see what’s 

happening at an individual patient level 

and the impact that delays in diagnosis or 

discharge have when the breakeven point 

has passed and the patient is making a 

loss for us,” he said. 

“We aggregate this up and take a look at 

pathways of care, to see how we can 

redesign services to promote better care 

pathways. And that’s where the 

transformation comes. We are no longer 

cost accountants; we are transformation 

and cost accountants. 

“Understanding cost and 

understanding what goes into cost is not 
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the same as rationing. It’s making sure 

that we make healthcare sustainable 

through that understanding.” 

Bedside data capture

NUH uses “Nerve Centre”, a bedside 

capture system using iPads or iPhones to 

record interactions with patients. Each 

day is tagged as red or green, recording 

whether an activity that leads towards 

discharge has been undertaken. This 

enables bottlenecks to be identi�ed and 

addressed. “It’s really not the costing that 

does this,” Hodgson said, “but the input 

information that we pull into the costing 

system that helps the users. We cost by 

the day so we can see the cost of a red day, 

the cost of a green day. We can ask, ‘Why 

did that red day happen?’ ” 

Red days require reason codes for 

delays; for example, “waiting for radiology 

test”, “waiting for pathology results”, or 

“waiting for a community care bed”. These 

codes can be played back to the clinicians 

who are using the system. In e�ect, the 

system is a supply chain, and the 

information collected helps the costing 

and clinical teams to look not just at one 

aspect but how it impacts or is impacted 

by the services around it. 

Queen’s Medical Centre is part of Nottingham University Hospitals,
 which provides services to more than 6 million people.
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Data for diabetes

One of the ways in which hospital data 

are being used proactively across the 

healthcare system is illustrated by the 

work Hodgson’s costing team has 

undertaken with local general 

practitioners. Data relating to a cohort of 

diabetes patients were shared and 

analysed to help medical professionals 

serving as consultants understand 

whether patients presenting at major 

hospitals are self-managing their 

diabetes e�ectively or will require 

stabilisation before their underlying 

condition can be treated. This work 

extends beyond traditional costing 

boundaries, Hodgson said. Linking the 

two systems together can ultimately save 

money for the healthcare system. “If we 

know that patients are on the diabetes 

register but are not managing their 

condition, what communication work 

can we do to get them to a clinic?” he 

said. “Do they know about clinics and 

support? We can target them and ensure 

that they get prevention support, because 

that is far cheaper than patching them up 

when they get into hospital. A lot more 

information is gained through 

combining the datasets — the sum of the 

two parts is far greater than the whole.”

Recent developments in healthcare 

solutions include government investment 

in “social prescribing”, which addresses 

issues such as loneliness, and by 

extension, better management of 

underlying health through therapeutic 

activities. But this growing focus on 

understanding patients at a granular level 

brings its own concerns for the �nance 

professional, Orme said. “It’s important to 

work very closely with information and 

governance leads to ensure that we 

comply with GDPR [the EU’s data 

protection laws], that everything we do is 

anonymised and is only available to the 

clinician responsible for that individual’s 

care,” he said.

Improving data quality is a key 

element of the costing role. Hodgson 

described the process for engaging 

clinical teams with the process. “We 

will publish data early, knowing that 

it’s not 100% correct,” he said. “But as 

soon as we put it out there and keep 

publishing it, people will start looking 

at it and start improving the quality of 

data. 

“In our early publishing of the red and 

green reason codes 80% of them were 

blank. But the fact that we were spending 

£20,000 a month on red days without 

knowing why soon raised awareness 

among clinicians. Realising that the 

codes would tell them where the money 

was going, clinicians now �ll in the 

codes and we have 90% completion.”

Skills and competences

Technology has freed up senior sta� time, 

allowing greater engagement with clinical 

colleagues. Hodgson explained that while 

junior sta� “turn the wheels”, getting data 

through the system and out, more 

experienced colleagues are using those 

same data for transformation. The 

o�ce-based bean-counter image is 

obsolete: Today’s cost accountant needs to 

have communication, presentation, and 

in�uencing skills, and be able to think 

outside the box. “Costing used to be a �rst 

job for people wanting to go on into 

business partnering,” Hodgson said. “But 

today a lot of our sta� come from 

�nancial management and management 

accounting roles, because they’re used to 

being part of a division in the hospital.” 

Technical skills are still crucial, Orme 

said. Cost accountants must maintain a 

separate cost ledger that cannot get out of 

balance with the general ledger, a practice 

that their last-century counterparts would 

certainly recognise. The ability to manage 

‘The whole point is to give the 
clinicians the information to 
make decisions. … We are here to 
guide them through the vast 
volumes of data.’
Scott Hodgson, ACMA, CGMA, head of costing for Nottingham University Hospitals

Nottingham University Hospitals’ costing team’s policy is to publish and debate 
results with clinicians, being mindful of the “Five Stages of Data Grief”. It has 
become adept at helping colleagues get across the stages very quickly and have 
found that peer-to-peer discussions can sometimes be key to removing 
barriers.

 1 Denial: “The data is wrong!”

 2 Anger: “It does not apply to me.”

 3 Bargaining: “I will get the correct data.”

 4 Depression: “There is nothing I can do about it.”

 5 Resolution: Acceptance and action.

5 stages of data grief

The
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Cost accounting took slow route to appreciation

A wartime yearning for efficiency and value evolved finance practices.

A
lthough it took centuries for business leaders to fully 
appreciate the utility of cost accounting, the practice 

— once embraced — established a value that remains 
essential to organisations throughout the world today.
 While the roots of modern cost accounting can be traced 
back to the 18th-century Industrial Revolution, progress 
towards professionalising the practice was slow. Cost 

Accounting Principles and Practice, a costing textbook 
published in 1920, a year after CIMA’s first incarnation as the 
Institute of Cost and Works Accountants, highlights the 
frustration of costing pioneers at the slow recognition of 
their value: 

Hardly any other feature of industrial procedure has been 
so necessary, yet so slow in developing, as cost 
accounting — so rich in possibilities of usefulness for 
management of business, yet so widely considered for 
many years as a doubtfully necessary evil.

By 1937, however, the Institute had published its first 
“Costing Terminology”, and cost accounting was well on its 
way to being established as a science. World War II saw 
increased demand for costing professionals in government 
and industry to help ensure efficiency and value for money. 
By the 1950s, costing played a key role in the ICWA 
qualification, in which seven of the 16 papers focused 
exclusively on costing (wages, materials, overheads, and 
methods). By 1975, the Institute of Cost and Management 
Accountants, as CIMA was then known, had been awarded a 
Royal Charter. The focus of the qualification began to shift 
towards strategic accounting, and in 1986 the ICMA became 
the Chartered Institute of Management Accountants.

An article by Roland Dunkerley, FCWA, in The Cost 

Accountant, the official journal of the Institute of Cost and 
Works Accountants and a precursor to Financial Management 

magazine, dated 1946, traces the early history of the costing 
profession. Driven by the changed industrial circumstances 

and economic conditions of World War I, costing practices 
evolved from the factory floor rather than the finance office, 
with a focus on efficiency. Dunkerley, who was the ICWA’s 
president in 1933–1934, wrote: 

It was necessary for [the cost accountant] to have 
considerable knowledge of the factory and its 
products, and to keep abreast of all the developments 
in management technique which were becoming 
more widely used: time and motion study, use of tools 
and jigs, causes of stoppages of machinery, layout of 
stores, questions of transport, and — by no means the 
least important — the devising of methods to give the 
maximum of information with the minimum of 
clerical work.

Rebecca McCaffry, FCMA, CGMA, 

is associate technical  

director–Management Accounting at 

the Association of International 

Certified Professional Accountants. To 

comment on this article or to suggest 

an idea for another article, contact 

Ken Tysiac, FM magazine’s editorial 

director, at Kenneth.Tysiac@ 

aicpa-cima.com.

huge volumes of data and pick out core 

messages is also essential to success (see 

the sidebar “The 5 Stages of Data Grief”). 

Hodgson agrees. “The whole point is to 

give the clinicians the information to 

make decisions, not for us to do it,” he 

said. “We are here to guide them through 

the vast volumes of data.”

Resilience is also a key skill for the 

costing practitioner. “We can’t tell our 

colleagues they are spending too much,” 

Hodgson said, “because we don’t know 

enough about clinical care. But we can 

present the information we have, and ask, 

‘Does this look right to you?’ Invariably 

they’ll say something doesn’t look right, 

and we work with them to improve it.”

The pace of transformation in 

healthcare is accelerating, Orme said, with 

clinicians ever more keen to understand 

costs, their practice, and their patients. As 

a result, cost accountants are once more at 

the forefront of health delivery. “If you 

have that enthusiasm, curiosity, and 

desire to understand, and wish to 

in�uence and help your clinical 

colleagues, then this is a cracking job for 

you,” Orme said.   Q
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‘It is obvious from its 
record that cost 

accountancy is a dynamic, 
and not a static, force. It is 

a profession  filled with 
possibilities and with  

great interests …’  
�e Cost Accountant, 1946
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Former Unilever CEO Paul Polman 

took on short-termism, climate 

change, and income inequality 

at the CIMA President’s London 

Centenary Dinner. 

By Oliver Rowe

O
n 8 March 2019, 100 years to the day after CIMA was 

formed, Paul Polman, HonFCMA, delivered a speech 

to the almost 200 guests at the CIMA President’s 

Dinner in Merchant Taylors’ Hall in London. 

Polman is chair of the International Chamber of 

Commerce, chair of The B Team, and vice-chair of the UN Global 

Compact, a voluntary strategic initiative to encourage businesses 

to achieve the UN’s Sustainable Development Goals. For ten years 

until December last year he led Unilever with a personal mission 

to “galvanise our company to be an e�ective force for good”.

It was highly appropriate that he spoke at the dinner. CIMA’s 

�rst president in 1919 was Lord Leverhulme, who founded Lever 

Brothers — the company that went on to become Unilever in a 

merger with Dutch company Margarine Unie in 1929.

Polman’s speech started by acknowledging CIMA’s route from 

its beginnings in 1919 and ended with a standing ovation. In 

between, he recognised International Women’s Day (also 8 March) 

and covered issues pertinent to a better future for business and 

humanity — and challenged accountants to play a greater part in 

achieving that. Here are some key (edited) quotes from the speech.

A challenge to

the profession  
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On short-termism

“We’re running [companies] into the ground with short-termism 

— this myopic focus on shareholders. There’s no question about it, 

especially when you think that 50% or more of the investments 

companies make create value for a company only three to �ve 

years out or more. It’s bizarre that we have let this happen. 

“Christine Lagarde [IMF managing director and chair] 

summed it up very well when she said … the �nancial sector 

[prioritises] … pro�ts over long-range prudence and short term 

over sustainability. That’s what is happening.”

On GDP

“How we de�ne GDP, industrial output — pretty narrow 

measure. Should have never been used as a measure of the 

wellbeing of a country. We produce more weapons or wage wars, 

GDP goes up. We produce cleaner air or better education, we 

don’t see anything in GDP. A little bit bizarre to me.”

On wealth inequality

“The �nancial crisis showed one thing to people in the street, if 

you like it or not. It showed that banks were too big to fail and 

people were too small to matter. It’s as simple as that.

“Many people have not seen any progress in the last 30 to 40 

years. Last year alone the bottom 3.8 billion people in the world, 

the poorest people, saw their combined net worth go down by 

11% … whilst the billionaires saw their net worth go up by 900 

billion [dollars], 2.5 billion a day.”

 

On equal pay for women and men

“[Some people] say, ‘Yeah, we know we have a di�erence, but 

between now and 2020, we’ll �x it. Or 2025, so we’re on it, we’re 

on it.’ Well, if you have a problem now, why don’t you �x it now?”

On climate change

“We can actually [limit the temperature rise to] one and a half 

degrees in the next 30 or 40 years if we decide to do so. If we 

don’t decide to do so, we’re about to commit the biggest 

intergenerational crime in the history of humankind. Let me be 

clear on that.”

On development goals

“It costs far less than the 10–12% of GDP that we are now 

spending [wastefully] on con�ict, defence, and wars than in 

implementing the total Sustainable Development Goals with the 

simple objective to irreversibly eradicate poverty and do that in a 

more sustainable and equitable way, to leave no one behind, to 

�nish the job that Ko� Annan [former UN secretary-general] 

started in the �rst 15 years of his Millennium Development 

Goals.

“On each of these famous 17 [Sustainable Development] 

Goals, the cost of not acting is now higher than the cost of acting. 

And we call ourselves the most intelligent species.”

Challenge to accountants

“What world are we steering ourselves to with our systems that 

we’ve produced, including our accounting systems? … Are we 

creating wealth for a few, a few islands of prosperity in oceans of 

poverty? …

“Now, we know how to optimise �nancial factors, but we 

won’t solve the issues of climate. We won’t solve the future of 

humanity if we don’t broaden that and also … optimise our 

return on not only �nancial capital, but also social and 

environmental capital. What’s wrong with that?”   Q
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Paul Polman, HonFCMA, 
speaks at the Centenary Dinner.

Oliver Rowe is an FM magazine senior editor. To comment on 

this article or to suggest an idea for another article, contact 

him at Oliver.Rowe@aicpa-cima.com.
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Technologies such as Excel help 

accountants work smarter and faster, but 

even greater efficiency is available to those 

who learn to use tech tools more effectively. 

By Kelly L. Williams, CPA, Ph.D., and Byron Patrick, CPA/CITP, CGMA 

quick technology tips 
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A
ccountants are always looking for 

ways to do more and better work 

in less time. Technology tools are 

great aids in that quest, but they 

can do even more if you know 

the right techniques. To celebrate CIMA’s 

centenary, FM magazine is pleased to present 

100 tips and tricks for better leveraging 

technologies such as Microsoft Excel (some 

features are available only in the latest 

Microsoft O�ce and Windows versions). 

A



Excel quick tips

1. Hide zero values. Including many zero values in your data 

can be distracting. To easily hide zero values, go to the File 

tab, Options, Advanced, and uncheck Show a zero in cells 

that have zero value.

2. Delete blank rows. You may have a spreadsheet with blank 

rows that are spread throughout the worksheet. Instead of 

deleting each blank row individually, you can delete all blank 

rows at once. For this to work, your header rows must be on 

the �rst row of the spreadsheet. Select the entire columns 

that contain your data by clicking on the letters at the very 

top of the columns. On the Data tab, Sort & Filter group, 

select Filter. Click the drop-down arrow on the right side of 

the �rst column of your data, uncheck (Select All), and 

check (Blanks). If any numbers are still visible, go to the 

second column of your data and repeat the step above. 

Continue to repeat the steps for each column until no data 

appear. Select the �ltered rows and go to the Home tab, Cells 

group, and select Delete. On the Data tab, Sort & Filter 

group, select Clear.

3. Name a cell or range of cells. A cell or a range of cells can be 

given a name in Excel. You can reference the name in your 

formulas and functions rather than trying to remember or 

�nd a speci�c cell or range of cells. To do this, highlight the 

cell or range of cells that should be named, then type the 

name in the Name Box (the box to the left of the formula 

bar). Click Enter.

4. Instantly select an entire table or data range. To instantly 

select an entire table or data range, click anywhere within the 

table or data range and press Ctrl+A.

5. AutoSum shortcut. To quickly sum a list of values, select 

the cell at the bottom of a vertical list of values or to the right 

of a horizontal list of values and press Alt+=, then Enter.

6. Quickly foot and crossfoot. AutoSum can be used to insert 

sum formulas that total all columns and rows at the same 

time. Highlight a table of data, plus one additional row below 

and one additional column to the right of the data. Click the 

AutoSum button or press Alt+=.

7. Transpose data. Sometimes you need data that are 

organised horizontally to be vertical, and vice versa. To do 

this, copy the data and place your cursor in the �rst cell you 

want the data to be pasted. On the Home tab of the ribbon, 

select Paste from the Clipboard group, then select Paste 

Special. Check Transpose, then click OK.

8. Sort data based on colour. Sorting data in Excel is not limited 

to sorting based on cell values. Data can also be sorted based 

on cell colour and font colour. To do this, select the data to be 

sorted. On the Home ribbon tab, select Sort & Filter from the 

Editing group, then select Custom Sort. Ensure that My data 

has headers is checked if headers were included in your 

selection. In the Sort by drop-down list, choose the column 

on which you want to sort. In the Sort On drop-down list, 

choose Cell Color or Font Color. In the Order drop-down list, 

choose the colour you want shown �rst. Next, click Add Level 

located at the top left of the Sort window. Complete the same 

steps as above for the second colour that should be shown, 

and so on until you have instructed Excel on the order in 

which to sort all cell colours or font colours.

9. Quickly resize a column to �t contents. You may have data 

in a cell that is much shorter than, or too long to �t in, the 

default width of a column. Instead of trying to manually 

adjust the width of the column to get the right size, double-

click the boundary between two column headers (eg, the line 

between the A and the B for the �rst and second columns), 

and the column size for the column to the left will be 

perfectly sized to accommodate the cell with the longest text.
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10. Extract characters from the left of a text string. You may 

need to extract a portion of data to the left of a text string. For 

example, you may need to extract the area code of a phone 

number. Use the function LEFT(Text, Num_chars). For 

Text, reference the cell that contains the text string. For 

Num_chars, enter the number of characters to the far left of 

the text string to extract. Click OK.

11. Extract characters from the right of a text string. You may 

need to extract a portion of data to the right of a text string. 

For example, you may need to extract the last four digits of a 

National Insurance number. Use the function RIGHT(Text, 
Num_chars). For Text, reference the cell that contains the 

text string. For Num_chars, enter the number of characters 

from the far right of the text string to extract. Click OK.

12. Extract characters in the middle of a text string. You may 

need to extract a portion of data in the middle of a text string. 

For example, you may need to extract digits in the middle of 

a product number. Choose the function MID(Text, [Start_
num], [Num_chars]). For Text, reference the cell that 

contains the text string. For Start_num, enter the position of 

the �rst character to extract (eg, if you wanted to start 

extracting at the fourth character in a text string, the 

Start_num would be 4). For Num_chars, enter the number 

of characters from the Start_num of the text string to 

extract. Click OK.

13. Merge multiple cells into one text string. You may need to 

combine data from various cells into one text string in one 

cell. You can also include spaces, symbols, etc, in the new 

text string you are creating. Choose the function 

CONCATENATE (Text1, Text 2, etc). For Text1, enter the cell 

reference, text, or any other characters for the beginning of 

the text string. For Text2, enter the cell reference, text, or 

other characters for the next part of the text string, and so on. 

For example, if you had a �rst name in cell A1 and a last name 

in cell B1, and you wanted to combine the �rst and last name 

into one cell with a space separating the two, you would 

reference cell A1 for Text1, enter a space (in quotes) for Text2, 

and reference cell B1 for Text3: CONCATENATE (A1," ",B1).
14. Hide/unhide worksheets. To hide a worksheet, right-click 

on the tab of the worksheet (located at the bottom of the 

Excel workbook) and select Hide. To unhide a worksheet, 

right-click on any tab of the worksheet, select Unhide, then 

choose which sheet to unhide.

15. Hide/unhide columns/rows. To hide columns or rows in a 

worksheet, select the columns or rows to be hidden, 

right-click within those rows or columns, and select Hide. To 

unhide columns or rows in a worksheet, select the columns 

or rows surrounding the hidden columns or rows, right-click 

within those columns or rows, and select Unhide.

16. Copy visible cells only. You may have a spreadsheet with 

hidden rows and/or columns but want to copy only the cells 

that are visible. To do this, click F5, Special, Visible cells 

only, OK. Then press Ctrl+C to copy.

17. Sum data from various places on a spreadsheet. You may 

need to sum values that are not all listed together in a 

spreadsheet. You can sum these values, but you cannot use 

the AutoSum shortcut or the AutoSum tool. Choose the 

function SUM. For Number1, select a cell or range of cells 

that will be included as part of the total. For Number2, select 

another cell or range of cells that will be included as part of 

the total. Continue for Number3, if needed, and so on until 

you capture all numbers that should make up the sum. Click 

OK. Example: SUM(A2,C9:C12,E5). 
18. Instantly copy a formula to multiple rows. Many of the 

formulas we use are intended to work for multiple rows of 

data. In that case, when a formula is added to your �rst row 

of data, that formula needs to be copied down to all rows of 

data. Instead of grabbing the Fill Handle (the solid green box 

that appears in the bottom right corner of a cell when it is 

selected) and dragging all the way down, it is easier and 

quicker to simply double-click the Fill Handle. This will 

work if the cells in the column to the left of the copied 

formulas are not empty. 

19. Freeze panes. When you have a large spreadsheet with titles 

for the columns and rows, it becomes di�cult to know 

which cell you are viewing if you have scrolled where you 

can no longer see the column and/or row titles. To keep the 

column and row titles on the screen, select the cell below the 

�rst column title and to the right of the �rst row title. On the 

View tab, select Freeze Panes from the Window group, then 

select Freeze Panes.

20. Visually represent your data using Sparklines. Sparklines 

are small charts that �t in a single cell and are used to 

visually represent your data (see cells G3:G5 in the screenshot 

“Sparklines Examples”). Select the cell or cells where you 

would like the Sparkline(s). On the Insert tab, within the 

Sparklines group, choose Line, Column, or Win/Loss. 

Select the data to be included in the Sparkline(s). 

21. Instantly convert a range of data into a table. To convert a 

range of data into a table, click anywhere within the range of 

data and press Ctrl+T.

22. Convert a table into a range of data. To convert a table into 

a range of data, click anywhere within the table and right-

click. Select Table, then Convert to Range.

23. Instantly chart a range of data. To chart a range of data, 

click anywhere within the range of data and press Alt+F1.

24. Switch between formulas and values. You can easily view 

your formulas by pressing Ctrl+` (grave accent). This will 

allow you to view all formulas. Clicking it again will switch 

you back to viewing values. 
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25. Change the case of text to all uppercase. To change text to 

all uppercase, click the cell where you would like the 

uppercase text to appear. Choose the function UPPER(Text). 
For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

26. Change the case of text to all lowercase. To change text to 

all lowercase, click the cell where you would like the 

lowercase text to appear. Choose the function LOWER(Text). 
For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

27. Change the case of text to capitalise the �rst letter of 

each word and all other letters to lowercase. To change 

the text to capitalise the �rst letter of each word and make all 

other letters lowercase, click the cell where you would like 

the converted text to appear. Choose the function PROPER. 

For Text, select the cell that contains the text to be converted. 

Then copy the formula down for all text.

28. Disable AutoCorrect one time for one situation. 

AutoCorrect can be very useful for �xing unintentional 

grammatical errors. However, sometimes Excel will continue 

“correcting” something that is not an error and should not be 

changed. You can instruct Excel to stop “correcting” this 

temporarily by typing the word, hitting the spacebar once, 

then clicking Undo or pressing Ctrl+Z.

29. Disable AutoCorrect permanently for one situation. You 

can instruct Excel to stop “autocorrecting” a word 

permanently by going to File, Options, Proo�ng. Select 

AutoCorrect Options and scroll down to �nd the word that 

Excel is autocorrecting. Click on the word and choose Delete. 

Click OK.

30. Create a Text Box. To create a text box, go to the Insert tab, 

Text group, and select Text Box. Left-click on the mouse and 

drag to create the borders of the text box. You can then type 

text inside the text box.

31. Convert formulas to values. To convert formulas to values, 

select all formulas or the entire worksheet or workbook and 

press Ctrl+C to copy. On the Home tab, Clipboard group, 

select Paste, then select Paste Special. Select Values, then 

click OK. Or, after copying, press Shift+F10+V.

32. Insert a line break within a cell. You may need to have 

multiple lines within a cell. For example, a heading for an 

income statement should include the company name, below 

that, the text “Income Statement”, and below that, the ending 

period. To have all three rows within one cell, you must 

insert a line break after each line of data by pressing 

Alt+Enter.

33. Find and replace. Find and replace has many useful abilities, 

such as �nding a misspelled word and replacing it throughout 

an entire worksheet; using a shortened word while creating a 

spreadsheet and replacing it with the long version when you 

are done; reusing a worksheet for a new client and instantly 

replacing the name; etc. Press Ctrl+H. Enter what you want to 

�nd in Excel next to Find what: (eg, old client name), then 

enter what you want the found data to be replaced with next to 

Replace with: (eg, new client name).

34. Display Excel with no gridlines. You can remove the 

gridlines from your Excel worksheet by going to the View 

tab, Show group, and unchecking Gridlines.

35. Add �lters to your data. To add �lters to your data, select 

the data to be �ltered. On the Home tab, Editing group, 

select Sort & Filter, then Filter.

36. Quickly switch between di�erent Excel �les. To quickly 

switch between di�erent Excel �les, press Ctrl+Tab.

37. Customise Quick Access Toolbar. The Quick Access Toolbar 

is at the very top left side of Excel (unless you have moved it). 

By default, the Quick Access Toolbar includes an icon to 

Save, Undo, and Redo. Click the drop-down arrow to the far 

right of the Redo icon, and you can customise this Quick 

Access Toolbar by adding or removing icons.

38. Customise status bar. The status bar is at the very bottom of 

Excel. By default, the status bar includes many status 

settings, including showing the Average, Count, and Sum of 

the data selected. These statistics can be very useful. If you 

right-click on the status bar, you can customise it to show 

more or fewer statistics and adjust other status features.

39. Preserve leading zeros. If you enter a number in Excel that 

begins with one or more zeros, Excel will delete the leading 

zeros. To keep the leading zeros, add a single quote in front 

of the �rst zero, and Excel will preserve the leading zeros, 

though it will treat the entry as text rather than a number.

40. Recover an unsaved workbook. Excel will autosave your 

Excel workbooks (by default, every ten minutes). If you have 

not previously saved your workbook and then close the 

workbook by mistake or if your computer closes without the 

workbook being saved, you can recover the document. Go to 

File, Open, Recent Workbooks, Recover Unsaved 

Workbooks, and choose the �le that was closed before it was 

saved.

41. Instantly create a PivotTable without learning about 

PivotTables. PivotTables are extremely useful tools, but if 

you have not yet had the chance to learn how to create one, 

Excel may be able to do all the work for you. Select the data to 

be included in the PivotTable, go to the Insert tab, Tables 

group, and select Recommended PivotTables. If there are 

enough data, Excel will give you some options of PivotTables 

to choose from.

42. Import a table from the web into Excel. You can import a 

table from the web into an Excel workbook. Go to the Data 

tab, Get & Transform Data group, and select From Web. 

Enter the URL of the webpage containing the table when 

prompted and click OK. Choose the desired table from the 

Navigator window and click Load.

You can repeat the last
action you did in Excel
by pressing Ctrl+Y.
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43. New workbook shortcut. To open a new workbook, press 

Ctrl+N.

44. New worksheet shortcut. To create a new worksheet, press 

Shift+F11.

45. Select all cells in a spreadsheet. To select all cells in an 

Excel worksheet, click the triangle to the top left of the 

spreadsheet located between column A and row 1.

46. Ensure your Excel workbook is accessible to people with 

certain disabilities. Various disabilities can cause a person 

to have di�culty comprehending certain content. Making 

content accessible is about improving characteristics of 

content that could otherwise limit a person’s 

comprehension. Excel can check your Excel workbook for 

accessibility. Go to File, Info, Check for Issues, Check 

Accessibility. Excel will then provide the results, which can 

include errors, warnings, and/or tips, or con�rmation that 

your content is accessible.

47. Repeat the last action. You can repeat the last action you 

did in Excel by pressing Ctrl+Y. This is a much more e�cient 

way of doing something in Excel that needs to be done 

repeatedly. 

48. Perform the same action to a group of consecutive 

worksheets simultaneously. If you need to perform the 

same action to multiple worksheets in your Excel workbook, 

you can group worksheets and perform that action only 

once. Left-click on the tab of the �rst worksheet to include, 

hold down the Shift key, and left-click on the last worksheet 

to include. You have now made those worksheets a group. Go 

to any of the worksheets and perform the desired action. You 

will see that action has been performed on all worksheets 

that were included in the group. When you are done, 

right-click on any of the worksheets in the group and select 

Ungroup Sheets.

49. Perform the same action to a group of nonconsecutive 

worksheets simultaneously. If you follow the instructions 

in the previous tip but use the Ctrl key instead of the Shift 

key, you can group individual worksheets that aren’t next to 

one another. 

50. Analyse components of a formula. Sometimes you need to 

analyse your formulas, possibly because you are getting an 

error message. One way to do this is by using a feature in 

Excel that shows you all the cells that are being used in the 

calculation of the formula. Click on the cell that contains the 

formula you want to analyse. Go to the Formulas tab, 

Formula Auditing group, and select Trace Precedents. This 

will display a blue arrow from all cells that are included in 

the formula.

51. Produce random numbers. To produce a list of random 

numbers, click in the cell that will contain your �rst random 

number. Use the function RANDBETWEEN. For the 

Bottom, enter the lowest number in the range of random 

numbers (eg, if you wanted numbers between 1 and 100, 1 

would be the Bottom). For Top, enter the highest number in 

the range of numbers (100 for the previous example). Drag 

that formula down (or across) as many times as needed to get 

the number of random numbers needed.

52. Remove duplicates. A dataset can have duplicate entries, 

such as a customer accidentally listed twice in a CRM 

database. To eliminate duplicate information, select the data 

you want checked for duplicates and go to the Data tab, Data 

Tools group, and select Remove Duplicates. Select all the 

columns you want Excel to check for duplicates (be careful 

only selecting something like last name when you could 

have multiple customers with the same last name). Click OK.

53. Quickly insert today’s date. To insert today’s date in your 

Excel worksheet, press Ctrl+; (semicolon). 

54. Quickly insert current time. To insert the current time in 

your Excel worksheet, press Ctrl+Shift+; (semicolon).

55. Format as numbers to include two decimal places, 

thousands separator, and a minus sign for negative 

values. To format as numbers to include two decimal places, 

a thousands separator, and a minus sign for negative values, 

press Ctrl+Shift+! (exclamation point).

56. Format as currency with two decimal places and 

negative numbers in parentheses. To format as currency 

with two decimal places and negative numbers in 

parentheses, press Ctrl+Shift+$ (dollar sign).

57. Format as percentage with no decimal places. To format 

as percentage with no decimal places, press Ctrl+Shift+% 

(percentage sign).

58. Strikethrough text. You may want to retain certain text but 

show a strikethrough on it. To do this, click the cell where 

you would like to include a strikethrough and go to the 

Home tab. Expand the Font group by clicking the arrow in 

the bottom right corner of that group, and put a check next to 

Strikethrough. Click OK.

59. Count the number of occurrences. You may need to count 

Flash Fill example (tip 60)

–
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the number of occurrences for certain things, such as the 

number of items in a list or the number of commissions 

earned by a salesperson, etc. Choose the function 

COUNT(Value1,[Value2] …). For Value1, select the cells that 

contain those occurrences. If there are other data to include 

in the count, include those for Value2 and so on. 

60. Quickly �ll cells with Flash Fill. Excel can automatically �ll 

in a column or row of data if it senses a pattern. For example, 

if your spreadsheet contains �rst and last names in column 

A, and you would like just the last names listed in column B, 

start typing the last names in column B and, once Excel 

senses the pattern, you will see all last names appear in 

column B, as shown in the screenshot “Flash Fill Example” 

on the previous page. Press Enter to keep Excel’s suggestions.

61. Visually represent your data using Data Bars. You can add 

Data Bars to cells to visually represent your data, as shown in 

the screenshot “Data Bars Example”. This can be helpful for 

interpreting and analysing data. Select the cells that you 

would like to contain Data Bars. On the Home tab, Styles 

group, select Conditional Formatting, then select Data 

Bars. Choose the colour of the Data Bars.

62. Round values up. Excel follows conventional rounding 

rules, but sometimes you may need to round up all numbers. 

Choose the function ROUNDUP(number, num_digits). For 

number, select the cell that contains the number to be 

rounded up. For num_digits, choose the number of decimal 

places to round. Then copy the formula down for all 

numbers.

63. Save Excel as PDF. To save a portion or all of your Excel 

workbook as a PDF, go to the File tab, Save As, Browse. 

Choose the desired location and type the desired name next 

to File name:. Next to Save as type:, choose PDF. Now, 

choose Standard (publishing online and printing) or 

Minimum size (publishing online). Click Options. Here, 

you can choose to include only a selection of a worksheet, an 

entire worksheet, or the entire workbook; document 

properties; etc. Click OK.

64. Embed Word, PDF, video, sound, or PowerPoint in Excel. 

To embed a Word document, PDF, video, sound, or 

PowerPoint slide(s), click in the Excel workbook where the 

object should be placed. On the Insert tab, Text group, select 

Object. To create a new object, select the object type on the 

Create New tab. To insert an object that has already been 

created, go to the Create from File tab and select Browse. 

Locate the object and double-click to select. You can check 

the Link to �le box if you want the embedded object to stay 

linked to the source �le and therefore be updated for any 

changes to the source �le. You can also check the Display as 

icon box, which will display the embedded object as an icon 

instead of the object itself. Click OK.

65. Increase numbers by a percentage. Excel can be used to 

increase numbers by a certain percentage. First, insert the 

amount of the percentage as a decimal added to 1. For 

example, a percentage increase of 20% would be entered as 

1.2 in a blank cell. Copy that number. Next, select the range of 

cells that should be increased by the percentage. On the 

Home tab, Clipboard group, select Paste, then select Paste 

Special. Select Multiply, then click OK. Your numbers will 

be changed to re�ect the percentage increase. See the 

screenshots “Percentage Increase Example” on the following 

page for an illustration. In this example, there is a list of 

products with their current prices. In order to change the 

prices to re�ect a 20% increase, 1.2 was entered in a blank cell 

(D1). That cell was copied, and the current prices were 

Data Bars example (tip 61)
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selected (B2:B10). Under Paste Special, Multiply was 

selected, and the prices for each product changed to re�ect a 

20% increase.

66. Use the “Tell me what you want to do” feature. There is a 

Tell me box located on the right of the last command on the 

ribbon in Excel. You can use this box to enter an action you 

want Excel to perform, such as freeze panes, print, or insert 

picture, or to get help on a particular subject. If possible, 

Excel allows you to immediately perform the action. The Tell 

me box will also allow you to get additional help on the 

subject you have entered through the Excel help content, or 

to use Smart Lookup, which browses the internet for help on 

the subject (see the screenshots “Tell Me Box Examples” on 

the following page). 

67. Insert hyperlinks. To insert a hyperlink in your Excel 

workbook, highlight the text, image, etc, that will be linked. 

Right-click and select Link. You can choose to link to an 

Existing File or Web Page and choose the path of the 

existing �le or enter the URL of the webpage. You can choose 

to link to a Place in This Document and choose the 

worksheet and cell reference/de�ned name. You can also 

choose a link to Create New Document or E-mail Address.

Beyond Excel tips

68. To quickly look at two windows side by side on a 

Windows computer, select a window, and press the 

Windows Key+left arrow key to “snap” it to the left side of 

your screen. You can snap a di�erent window to the other 

half of the screen by selecting the window and pressing the 

Windows Key+the right arrow. 

69. Set up Google Alerts for clients, customers, bosses, leads, 

family, etc. Visit google.com/alerts and set up your search 

criteria. Try to be as speci�c as possible to avoid false positives. 

There will be a preview of your search, as shown in the 

screenshot “Google Alerts Search Box” on the following page.

70. Use a password manager, which provides better security 

than trying to remember a bunch of di�erent passwords and 

also is incredibly convenient!

71. Turn o� all unnecessary noti�cations on your phone. 

The unnecessary interruptions to your day impact 

productivity signi�cantly. Don’t approach this all at once: As 

you receive noti�cations, decide if the noti�cation is 

mission-critical or can be silenced. 

72. When searching Google, hold down the Ctrl key when 

clicking links to open each link in a new tab. This way you 

never lose track of the search results page.

73. Use search whenever possible on your PC, on your phone, 

and in your email. On a Windows 10 PC, you can just begin 

typing after clicking the Start button. 

74. Windows Quick Assist, which is built into Windows 10, is 

an extremely easy method to share your screen without the 

need to download and install anything. To access easily, 

search (with tip 73) for “Quick Assist”.

75. Right-click on apps pinned to the taskbar to bring up lots 

of hidden options for various applications.

Percentage increase example (tip 65)
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Tell me box examples (tip 66)

76. Use the Save as PDF option built into Microsoft O�ce. No 

need to print and scan or use a third-party app.

77. Realise the power of touch. Microsoft O�ce ribbons are 

optimised for touchscreen. If using O�ce on a device with a 

touchscreen, press various menus with your �nger and see 

the di�erence. 

78. Stop typing the same email. Use Quick Parts in Outlook to 

quickly insert text you type out all the time. 

79. Change the time zone. When setting a diary appointment 

with someone in another time zone, change the 

appointment to invitee time zone to avoid mistakes. For 

example, if you are in Eastern time in the US and the other 

person agrees to meet at 1pm in London, simply change the 

appointment to London time and set it for 1pm.

80. Embed your videos into presentations. Stop linking to 

videos that won’t play o�ine. Move the presentation to 

another computer to test. Disconnecting from the internet 

isn’t a good enough test. When inserting your video, do not 

click Link to File. Instead, always choose Insert, as shown 

in the screenshot “Insert Video Example”. 

 

Google Alerts search box (tip 69) Insert video example (tip 80)
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81. Disable background data on your phone. It doesn’t just 

save data usage, it saves a lot of battery. For iPhone the 

feature is called Background App Refresh. Go to Settings> 

tap on General>scroll down and tap on Background App 

Refresh>toggle Background App Refresh o�. On Android 

the feature is called “Data Saver”. Go to Settings> 

Connections>Data Usage>Data Saver>toggle O�.

82. Use the Steps Recorder in Windows to record instructional 

steps to share with someone quickly.

83. Check the lighting. When on a video meeting, make sure 

you have adequate front lighting. For a quick and easy 

solution, try a USB LED light strip. By sticking it to your 

monitor, it will provide just enough front-facing light 

to provide good video quality. See an example at  

amzn.to/2F4kZ0c.

84. Use the mute button when not speaking on conference 

calls/video meetings. You can’t hear your own background 

noise, but everyone else can.

85. Use the built-in PowerPoint laser pointer when 

presenting your screen in a remote meeting. The virtual laser 

pointer is available either at the bottom right of a 

presentation screen or from the Presenter View.

86. Link your phone to your Windows 10 PC. Use the 

Microsoft phone companion app to send and receive text 

messages on your PC. From Windows 10 search for “Your 

Phone” and the app will walk you through the con�guration.

87. Integrate Cortana with your email, and Cortana will send 

you daily “Heads-up” reminders to follow up on things you 

said you would do in your email. For example, if you write in 

an email, “Je�, I will send you the schedule tomorrow”, 

Cortana will send you a reminder to send Je� the schedule. 

On your PC, search for “Cortana” and open the Search and 

Settings, and under the Permissions section click Manage 

the Information Cortana can access from other services. 

You will be able to select your email source and con�gure 

access. This will enable the Cortana reminder emails.

88. Always use multifactor authentication when it’s available 

in the application you want to use.

89. Use Bit.ly to shorten long URLs. As a bonus, you can track 

how many people click the links.

90. Open PDFs in Microsoft Word to quickly convert a PDF to an 

editable document. Open Word and from the Open menu 

select the PDF you would like to convert.

91. Use the “Delay” option in the Snipping Tool to capture 

menus that don’t stay open when you click New. One of the 

authors used a two-second delay to capture the snip titled 

“Snipping Tool Delay Option”.

92. Enable Clipboard history and use Windows Key+V to access 

multiple items on your clipboard. To enable it, search 

“Clipboard” on your PC and select Clipboard Settings.

93. Use the Morph transition in PowerPoint to easily animate 

objects. Morph is available in the Transition tab. To use it, 

duplicate a slide you have already created, move/resize 

objects on the second slide, and apply the Morph transition 

to both slides. 

94. Save your favourite animation. If you have a favourite 

Snipping Tool Delay option (tip 91) 
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To insert a hyperlink in 
your Excel workbook, 
highlight the text, 
image, etc, that will be 
linked. Right-click and 
select Link.
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Dynamic lock dialog box (tip 98) 

Insert screenshots example (tip 99) 

animation you want to use throughout your presentation, 

you can easily apply the same PowerPoint animations on 

every slide by adding the animation to the Master Slide. From 

the View ribbon select Slide Master and apply your edits.

95. Insert signature lines in Word. If you need to add a line 

where someone can sign in a Word document, choose the 

Signature Line option in the Text group on the Insert tab. 

96. Go back in time. Looking for something you were working 

on “the other day”? Press Windows Key+Tab to open a 

timeline of your activities in Windows.

97. Protect your computer from attack. Use Controlled Folder 

Access in Windows to protect your computer from potential 

ransomware attacks. 

98. Lock your computer when you are away. Use Dynamic 

lock to automatically lock your computer when you walk 

away from it with your phone. Search for it on your PC and 

click on the checkbox as shown in the screenshot “Dynamic 

Lock Dialog Box”.

99. Quickly insert screenshots into MS O�ce documents 

using the Insert>Screenshot option as shown in the 

screenshot “Insert Screenshots Example”. This feature will 

o�er you all of the windows that are already open without 

having to snip them.

100. Keep tabs on your apps. When using Alt+Tab to move 

between apps, you can use your mouse (or touchscreen) to 

quickly select the app you want to switch to.   Q

Use the Steps Recorder
to share instructional
steps with someone
quickly.
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W
hen the giant German 

conglomerate 

thyssenkrupp needed a 

new tower to test its 

lifts technology, the 

company originally planned to go the 

simple route, with an industrial, 

utilitarian design. It made �nancial sense: 

After all, the buildings used to test lifts’ 

capabilities are purely functional 

structures that are rarely viewed by the 

public. There’s no reason to invest in their 

appearance.

But then the company’s leaders had a 

change of heart. The new tower would be 

located close to a historic German town, 

and the leaders didn’t want to erect an 

eyesore that would mar the landscape. 

“We talked about it and thought, ‘Why 

don’t we do it as impressive architecture?’” 

remembered Katrin Hünger, CFO, 

Innovation Center of thyssenkrupp 

Elevator AG. It was a hard decision and a 

new one for the division, she said, but 

ultimately the senior sta� were all open to 

trying something di�erent. 

That was around 2012. Five years later, 

in the historic town of Rottweil, Germany, 

thyssenkrupp held an opening ceremony 

for its new, striking 246-metre-high tower 

with an unusual helical design. That’s 

when the senior sta� had a realisation, 

recalled Hünger: “We noticed that the 

Architecture 

that builds 
value 
Done well, it can pay off with more 

than just customers.

By Amanda Abrams

that builds 
value value 
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tower had the potential to become an 

icon, a symbol for thyssenkrupp with a 

certain marketing bene�t.”

That observation was an 

understatement. Since its opening in 2017, 

the tower has received enormous media 

attention, attracted hundreds of 

thousands of visitors, and potentially 

shifted public perceptions of 

thyssenkrupp itself. In short, the tower’s 

distinctive architecture now serves as a 

strategic and highly public calling card, 

allowing thyssenkrupp to rebrand itself 

and illustrate, in the most tangible way, 

the strengths and values it wants to 

promote.

Obviously, not every company has, or 

needs, a soaring tower to show o� to the 

world. But for those considering an 

upgrade to their physical facilities, 

architecture can be a remarkably strategic 

decision. Experts and businesses that 

have gone that route say a building’s 

unique design can help a company stand 

out to clients, appeal to customers, and 

— particularly important at a time when 

talented workers are a precious resource 

— attract potential employees.

Thyssenkrupp’s 246-metre-tall tower 
dominates the skyline above Rottweil, Germany.
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A soaring helical tower

A blue-chip manufacturing company with 

a February market cap of €9.8 billion ($11 

billion) that started out as a steelmaker in 

the 1800s, the company is undergoing a 

major restructuring with a planned split 

between the industrial and materials 

groups. Thyssenkrupp had already begun 

strategically thinking about how 

architecture informed its reputation in 

the early 2000s, when it contemplated 

building a new headquarters. Generally 

perceived as solid, reliable, and perhaps a 

bit staid, the company was looking to 

create a new image for itself. 

In the end, the business invested in an 

environmentally sustainable, 

architecturally distinct low-rise campus 

in Essen, Germany, that opened in 2010. 

The hope was that the modern 

headquarters would help shape a new 

public perception of thyssenkrupp as an 

innovative, dynamic, and technologically 

savvy business. 

So the construction of thyssenkrupp’s 

test tower had a precedent, although 

leaders in the lift division say their 

decision was made independently. While 

architecture. In response, the lift 

division’s leadership decided to create 

something di�erent, “something very 

special that is capable of gaining attention 

internationally,” Hünger said. 

Thyssenkrupp’s leaders had a hunch it 

could also pay o� by shifting the 

business’s image. With an innovative 

tower, “we can show we’re a tech-driven 

company”, Hünger said.

After soliciting bids from architects, 

the company chose Werner Sobek and 

Helmut Jahn, who produced a design for a 

246-metre tower clad in a unique 

glass-�bre “skin” and with an observation 

deck at the top. In December 2014, 

thyssenkrupp held a ground-breaking 

ceremony. 

“Of course, it’s not always easy to talk 

with [architects] — you have to �nd a way 

to have imagination, but it has to also be 

very industrial,” Hünger said. Once 

construction began, the company’s 

project managers had to stay on top of the 

building’s progress, which required 

intense coordination; at the peak of its 

construction progress, the tower grew by 

four metres a day. “The construction of 

not particularly well known, the 

company’s lift division is large — it earned 

€866 million ($980 million) before 

interest and taxes in 2017–2018 — and 

remarkably high-tech. The division builds 

the ropeless MULTI lift that can move 

sideways and diagonally, as well as up and 

down. But those newer forms need towers 

where they can be tested at high speeds. 

Formerly, all of thyssenkrupp’s test 

towers were indistinct and somewhat 

hidden away. “Our industry used to build 

elevator test towers in industrial zoning 

areas where hardly anybody would notice 

them,” said Hünger. 

But the company’s leaders felt that the 

tower planned near Rottweil — which is 

the oldest town in that part of southern 

Germany — should somehow 

complement the area’s historic 

Visitors look out over 
the countryside from the 
thyssenkrupp tower’s 
observation deck.
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the tower was a challenge for everybody 

involved. We hadn’t done anything like 

this before.”

But the project �nished largely on 

time, at a total cost of €40 million ($45.2 

million). Hünger, who is in charge of the 

lift division’s �nances, estimates that the 

tower’s spectacular architecture added 

10% to 15% to the total cost.

It’s an investment that has paid o� in 

multiple ways since the tower opened in 

October 2017. First, there’s an overtly 

�nancial aspect that took Hünger and her 

colleagues by surprise. “The tower has 

become a tourist attraction. Visitors come 

from all over the world,” she said. 

Thyssenkrupp had originally estimated 

attracting 100,000–150,000 visitors during 

the tower’s �rst couple of years. In fact, in 

the �rst 12 months after it opened, 

230,000 people paid the €9 entrance fee to 

ascend to the viewing platform and look 

out over the countryside.

It has also paid o� in media coverage. 

According to Jasmin Fischer, head of 

media relations for the lift division, 

almost 2,000 stories about the building 

appeared in print and online publications 

in 91 countries in the �rst year after the 

opening. The articles mention the unique 

tower, of course, but many also describe 

the company’s innovative lifts. Media 

attention has been so strong that 

thyssenkrupp didn’t have to spend a 

single euro advertising the tower or the 

lift division’s products in the �rst 12 

months after the tower opened, Fischer 

said. 

Having a physical presence also 

supports the sales process. Before, 

thyssenkrupp’s lift division lacked a single 

building where it could demonstrate the 

range of its products. Now the tower 

serves as a showroom: Potential buyers 

can come to Rottweil, ride to the top, and 

examine the lift options in person. And 

the tower also earns money as an event 

space; local businesses frequently book 

the rooms at the top for meetings and 

activities. 

However, Hünger said that the most 

profound bene�ts of having invested in 

an iconic tower aren’t so immediately 

apparent. “What you cannot assess by 

looking at these numbers is the enormous 

image boost for thyssenkrupp as a brand,” 

she explained. Formerly, the company’s 

lift division was largely invisible to the 

public. (“You go into an elevator and ask 

yourself if you’ve seen the brand there,” 

Hünger pointed out.) The test tower’s 

unique architecture has given the division 

a very public identity, one that’s bold and 

forward-looking. “We love the fact that the 

tower fosters our image as a technology 

company and elevator manufacturer, 

instead of presenting thyssenkrupp solely 

as a steel supplier, as we are often 

perceived by the public.” 

And that also improves employee pride 

and helps to attract new talent. “It’s a hard 

competition here in Germany for all the 

engineers,” said Hünger, who also 

oversees the division’s research and 

development wing. “It’s a good way to 

show that we are innovative and investing 

in the future.”

The company has been so pleased with 

the outcome that it is planning something 

similar in the US. Thyssenkrupp has 

already broken ground on its North 

American headquarters in Atlanta. The 

campus will be accompanied by another 

architecturally distinct test tower, and 

thyssenkrupp hopes it will receive a 

similar level of attention and acclaim. 

The messages architecture 

can send

There’s nothing new about companies’ 

use of architecture to gain visibility or 

convey a particular set of values. Big 

corporations have long employed 

impressive buildings to highlight and 

elevate their status; those entrusted with 

the public’s money, such as banks and 

insurance companies, have often 

constructed imposing facades to indicate 

their seriousness and reliability. 

Iconic corporate architecture became 

particularly popular in the 1960s. In the 

US, for example, technology companies 

such as IBM and Bell Labs employed 

big-name modern architects such as Eero 

Saarinen and Charles and Ray Eames to 

design their buildings, underscoring the 

companies’ future orientation. 

Today, tech companies are still driving 

some of the trends in corporate 

architecture. Open plan o�ces, exposed 

brickwork, and whimsical features such 

as slides, for example, originated in IT 

o�ces and have now become so 

ubiquitous as to be clichés. More broadly, 

companies from a range of industries feel 

pressure to appear innovative and 

forward-thinking at a time when new 

technology in�uences ideas and products 

around the world.

But there’s been a key shift. These days, 

companies create distinctive facilities not 

simply to appeal to consumers, but to 

attract and retain key talent. 

“The architecture does need to convey 

a sense to the broader public, but the real 

focus is the user,” explained Paul De 

Santis, project designer for Zurich 

Insurance Group’s North America 

headquarters and partner with Goettsch 

Partners, an architecture �rm with o�ces 

in Abu Dhabi, Chicago, and Shanghai. 

“The idea that you’ll be able to attract the 

highest-quality people and retain 

‘There’s a generation of people 
looking to work for best-in-class 
companies, and they expect to be in 
best-in-class facilities.’
Paul De Santis, project designer for Zurich Insurance Group’s North America headquarters 

and partner with the architecture �rm Goettsch Partners
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high-quality sta� is a massive thing, no 

matter whether you’re in Germany or 

China or the US. And architecture plays a 

very big role in that. There’s a generation 

of people looking to work for best-in-class 

companies, and they expect to be in 

best-in-class facilities.”

Indeed, the US, Europe, Japan, and 

many other places are su�ering from 

intense labour shortages, particularly in 

industries that require specialised 

technical knowledge. Companies are 

competing for skilled workers — many of 

whom are seeking more than simply a 

nice paycheque. 

“People want to be proud of the place 

where they work,” said Matthias Hollwich, 

principal and co-founder of the New 

York-based architecture �rm HWKN. “It’s 

not just about making six �gures and 

driving a BMW — nobody cares about the 

BMW anymore, and with six �gures it’s 

like, ‘OK, but what else do you do?’ [The 

job] is also about lifestyle, quality of life, 

purpose.” And it doesn’t hurt, Hollwich 

added, if all of that can be documented on 

intensely image-focused social media.

Standout architecture can �ll many of 

those roles. That’s what the leaders of 

Suzlon Group, a global renewable energy 

company based in Pune, India, had in 

mind when they built a new headquarters 

in 2009. Named Suzlon One Earth and 

with a capacity to house 2,300 workers, 

the 10-acre campus boldly advertises the 

company’s values: It is LEED Platinum-

certi�ed and completely powered by 

renewable energy, with rainwater 

harvesting facilities and on-site waste 

conversion.

The company designed the campus to 

appeal to employees’ emotional and 

intellectual needs in order to inspire 

creativity and innovation in the 

workforce. 

The Leonardo Glass Cube in 
Bad Driburg, Germany, is the 
headquarters and showroom 
for German glassware company 
Glaskoch.
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But an inspiring facility can appeal to 

other important players as well: potential 

partners and clients.

 

The benefits of a modern glass cube

“You cannot have the same showroom 

you have had for 20 years and then tell 

people about the future,” said Oliver 

Kleine. The director and �fth-generation 

owner of Glaskoch Corporation, a German 

glassware company, explained why the 

160-year-old business built a new 

headquarters and showroom in 2007.

Around 2003, the company — which 

operates under the brand name Leonardo 

— began thinking about becoming a 

lifestyle company, with a broader product 

line that included furniture, tabletop 

items, and jewellery. That led to questions 

about the space that the company was 

using to show o� its goods. “We started to 

think about architecture because I don’t 

want to only speak about the future and 

the vision, but to show that people really 

can live it,” Kleine said. 

Kleine met the owners of 3deluxe, the 

architecture �rm that ultimately designed 

Glaskoch’s new space, at an exhibition 

and quickly felt a connection with them. 

At that time, 3deluxe was a young 

company that hadn’t yet created any 

permanent buildings. Kleine was willing 

to take a risk on its architects. “Somehow, 

I knew that when they were working on 

something for the �rst time, they would 

give much more of their passion than 

well-known architects, where you pay for 

the name,” he said. 

The result is the Leonardo Glass Cube, 

a 1,200-square-metre building in Bad 

Driburg, Germany, that combines 

naturalistic lines — think of a turtle shell’s 

design — with a lot of glass. It’s a 

stunning, unusual-looking facility that 

ultimately cost Glaskoch about €10 

million ($11.3 million). 

Kleine said it has been worth it. “I 

think everybody is quite proud of having 

such nice architecture,” he said, referring 

to Glaskoch’s 280 employees, who can 

enjoy the facility’s gleaming terrace on 

nice days. 

Just as important, the building has 

attracted a huge amount of public interest 

that — as in the case of thyssenkrupp — 

has bene�ted the company �nancially. 

“Every year, we have three or four 

commercial things happening here,” Kleine 

said. Movie scenes and advertisements 

have been �lmed in the glass cube, bands 

have held concerts, and other companies 

have used the space for expositions. Fees 

for use of the space, particularly in the case 

of crews shooting scenes for �lm and 

television, nearly cover the building’s 

overall operating costs, including heating, 

cooling, and electricity. 

But perhaps the greatest bene�t of 

having an ultramodern building is the 

impression it immediately conveys about 

the business. Kleine explained that back 

in 2009, the company was aiming to 

expand into furniture, and he and his 

colleagues met with other brands to 

discuss Glaskoch’s plans. 

“The �rst companies asked why we 

wanted to do it. We had to �nd a way to 

show them what our philosophy was, so 

we showed them this glass cube. And after 

that, there were no more questions,” he 

said. “It’s a very nice tool for new business 

development. They see the building, they 

like it very much, then they go inside and 

see what we’re doing, and very often 

they’re impressed. I don’t know how it 

would’ve been if we didn’t have the cube.”

Of course, Kleine has been lucky: Even 

after ten years, the building still looks 

modern and fresh. Aside from cost, that 

may be the other big downside to 

investing in unique architecture as a 

branding tool: Although not always true, a 

contemporary design could look dated 

after a few years and may no longer appeal 

to potential employees and clients or to 

the public. 

Still, for those that put in the time and 

calculations to get it right, great 

architecture can seriously pay o�.   Q

These days, companies create 
distinctive facilities not simply to 
appeal to consumers, but to attract 
and retain key talent.

Amanda Abrams is a freelance writer 

based in the US. To comment on this 

article or to suggest an idea for another 

article, contact Drew Adamek, an  

FM magazine senior editor, at  

Andrew.Adamek@aicpa-cima.com.



A free toolkit helps companies employ effective strategies 

to promote ethical practices within their supply chain.  

By Pauline Dibben, Ph.D.; John Cullen, FCMA, CGMA; Gareth Crockett, Ph.D.; 

Juliana Meira, Ph.D.; and Geoffrey Wood, Ph.D.

E
thical employment practices 

and resilient supply chains are 

essential ingredients of a 

reputable and sustainable 

business. Worker tragedies in 

emerging economies, such as the collapse 

of the Rana Plaza textiles factory in 

Bangladesh in 2013 that killed more than 

1,100 people, evidence of child labour in 

the production of mobile phones and 

batteries, and worker suicides at Foxconn 

in China, along with media coverage of 

those events, have made organisations 

increasingly aware of the need to know 

what happens down the supply chain and 

take responsibility for it. Failure to take 

responsibility can seriously undermine 

brand identity for many years, as many 

companies have discovered over time. 

The Supply Chain Accounting and 

Employment Practices (SCA-Emp) 

research team, a multinational 

collaboration of academics and industry 

representatives, found that few 

A tool to

strengthen

the supply chain 
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companies employ e�ective strategies to 

promote ethical practices within their 

supply chain. The research team, which 

received funding and guidance from 

CIMA, also found that many companies 

miss out on opportunities to employ 

accounting techniques that could make 

their supply chains more resilient. 

These �ndings were incorporated into 

the SCA-Emp Diagnostic Toolkit, which 

was designed to help accountants, human 

resources professionals, and supply chain 
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managers work together to ensure ethical 

HR and accounting practices within their 

organisation and throughout the supply 

chain. 

The toolkit was launched in 2016 and 

has been downloaded by companies in 

more than 20 countries.

What were the main findings?

The SCA-Emp project aimed to identify 

good practice and �nd out how (and 

whether) companies were checking on 

their suppliers’ practices. What were they 

doing inside the company? Did they 

monitor their suppliers? And did they 

promote labour standards? 

In 2014, the research team carried out 

a detailed survey of more than 100 

automotive and textile companies in 

Brazil and South Africa, involving major 

retailers, original equipment 

manufacturers, and �rst-, second-, and 

third-tier suppliers. It also drew on 

in-depth interviews with accounting and 

�nance managers, HR managers, CEOs, 

supply chain managers, trade unionists, 

professional bodies in accounting and 

HR, nongovernmental organisations, and 

employer organisations. 

We observed that, in practice, many 

companies have little knowledge of 

supplier behaviour. We found that many 

companies shared information with their 

customers and suppliers on 

manufacturing processes but not on costs 

or employment practices (such as 

training, recruitment, performance 

management, and diversity) unless a 

problem arose. Most companies (70% of 

those surveyed) had an equal 

opportunities policy within their own 

organisation, but we found limited 

transparency through the supply chain. 

Also, within the companies themselves, 

there was limited diversity in terms of the 

people employed, especially in 

management roles. 

In the automotive companies studied, 

knowledge of suppliers’ employment 

practices rapidly diminished as you 

moved down the supply chain. Although 

Brazilian automotive companies still had 

strategic alliances with tier-one suppliers, 

How to get the toolkit

The SCA-Emp toolkit is a free 
resource, available to download at 
www.sca-emp.com as an Excel file, 
or it can be completed online 
(registration is required).

The toolkit includes seven sections 
containing statements on supply 
chain management, employment 
practices, accounting, and monitoring 
of suppliers. It is a self-evaluation 
tool that includes suggested actions. 
The online version provides users 
with a report based on their 
responses.

To find out more about the 
research project or the toolkit, email 
Pauline Dibben at p.dibben@sheffield.
ac.uk. 
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cost-cutting pressures had led to 

arm’s-length contracting further down the 

supply chain, particularly when sourcing 

from companies in Asia. 

In South Africa, tier-one suppliers were 

heavily involved in the �nal production 

process, but outsourcing had meant that 

workers were often given inferior 

employment conditions. In clothing and 

textiles �rms, jobs were much more likely 

to be short-term, with problems around 

health and safety, and a lack of e�ective 

worker voice. In rural areas, self-employed 

workers were used, though they were not 

monitored by the government or taxed. 

The sector as a whole was struggling to 

survive, due to the availability of cheap 

imports from China and South Asia.

These �ndings helped to inform the 

SCA-Emp Diagnostic Toolkit.

What accountants can do to 

promote resilient supply chains 

Our research suggests that many 

organisations miss out on important 

opportunities to make their supply chains 

more resilient. Finance professionals can 

play an important role in helping their 

organisation achieve this goal by:

yyy Identifying ways that their skills can 

complement those of procurement 

and supply chain colleagues, 

and working together to explore 

those opportunities. For instance, 

accountants are able to bring 

their diagnostic skills, using tools 

such as open book accounting 

or make-or-buy, to inform other 

colleagues of the costs and bene�ts 

associated with di�erent scenarios. 

The accounting section of the 

SCA-Emp toolkit can help identify 

ways to do this.

yyy Encouraging other colleagues and 

departments to get involved in the 

supply chain as well and to use the 

toolkit as a strategy planner. For 

instance, HR practitioners bring 

skills around con�ict resolution, 

which can help identify the best 

course to take if industrial action 

such as strikes a�ect the supply 

chain. They might also be able to 

help interpret data on suppliers’ 

employment practices with the 

intention of identifying potential 

instances of labour exploitation and 

therefore help prevent the risk of 

damage to brand image.

yyy Trying to build strong relationships 
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Pauline Dibben, Academic FCIPD, 

Ph.D., is a professor of employment 

relations; John Cullen, FCMA, CGMA, 

is a professor of management 

accounting; Gareth Crockett, Ph.D., is 

a research associate; and Juliana 

Meira, Ph.D., is a lecturer in 

management accounting, all at the 

University of Sheffield Management 

School in the UK. Geoffrey Wood, 

Ph.D., is dean and professor of 

international business at the Essex 

Business School in the UK. To 

comment on this article or to suggest 

an idea for another article, contact 

Sabine Vollmer, an FM magazine 

senior editor, at Sabine.Vollmer@

aicpa-cima.com.

with customers and suppliers. Our 

research suggests that long-term, 

trusting relationships between 

customers and suppliers boost 

competitive advantage for both. 

Sharing �nancial data between 

customers and suppliers (eg, by 

using open book accounting) 

can help to identify cost savings 

and prevent unexpected supply 

interruptions.

��y Not being afraid to ask customers 

or suppliers for employment 

information. We found that many 

�rms share data on production 

processes or product speci�cation, 

but they rarely inform one another 

about labour costs and practices. 

This can help to highlight instances 

where workers are not being treated 

well — for example, by being paid 

less than the minimum wage. 

Sharing this type of information 

relies on trust, which can take 

time to build, but you can start 

small. You don’t need to share 

con�dential information to make 

improvements. For example, after 

using the toolkit, an agricultural 

business in South Africa with fewer 

than 100 employees introduced 

more professional procurement 

practices (eg, taking into account 

cash �ow management issues), and 

this enabled the business to create 

better relationships with suppliers 

and develop more sophisticated 

production practices. 

��y Using the checklist in the SCA-Emp 

toolkit to help to evaluate current 

suppliers or to aid supplier selection. 

The toolkit can be used as part of 

the assessment criteria to create a 

preferred supplier list. Some �rms 

have used the toolkit to integrate a 

more ethical dimension into their 

sourcing policy by asking suppliers 

to complete the toolkit at the point 

of registration and to review it at 

regular intervals. The completion of 

the toolkit by suppliers is an integral 

part of identifying and promoting 

best practices with preferred 

suppliers.

How to use the toolkit

The toolkit will appeal to companies and 

practitioners that wish to improve the 

competitiveness and resilience of their 

supply chain and to those keen to prevent 

damage to their brand that could arise if 

poor labour standards in supplier �rms 

are exposed.

Companies can use the toolkit to check 

current practices within the �rm, to plan 

strategy across departments, or to 

benchmark existing suppliers and 

evaluate potential suppliers. 

Results obtained by toolkit users 

Examining the aspects of the business 

highlighted in the toolkit has helped 

organisations around the world tackle 

several performance issues. 

Organisations from across the world 

have used the toolkit to: 

��y Increase employee productivity and 

pro�ts; 

��y Improve communication with 

employees and relationships with 

customers and suppliers;

��y Enhance their focus on ethics and 

quality; 

��y Improve knowledge of the supply 

chain and work toward better 

integration of departments within 

the organisation; and

��y Embed forms of best practice 

throughout the organisation. 

An automotive company in Brazil has 

drawn on ideas from the toolkit to 

promote its performance appraisal 

system, improve bene�ts and training 

for employees, and enhance interaction 

between the accounting and commercial 

team. Between December 2016 and 2017, 

it developed better relationships with 

customers and saw an increase of around 

7% in productivity, 5% more business, and 

a 2% increase in pro�ts. Company 

directors informed us that they 

attributed much of this improvement to 

their use of the toolkit. A second 

automotive company in Brazil is now 

modelling best practice to other 

automotive companies, and during a 

time of economic crisis, managers felt 

that their experience using the toolkit 

helped them to maintain a focus on 

ethics, values, and strategy.

A large UK local authority uses the 

toolkit as a central part of its ethical 

procurement strategy. The initial phase 

of this process focuses on its largest 

suppliers and will then be rolled out to 

its smaller suppliers. The toolkit will 

then subsequently be used to assess 

potential new suppliers.   Q

Finance professionals can help make 
the supply chain more resilient by 
building relationships with 
customers and suppliers.
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When scouting for high-potential talent, 

the first place to look could be in-house. 

By Hannah Pitstick

Watch for these 

signs to spot
your rising stars 
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A
s �nance and accounting 

teams experience talent 

shortages, due in part to the 

retirement of Baby Boomers, 

limited applicant pools, and 

a rising demand for new technology skills, 

many are �nding it more di�cult than 

ever to spot and nurture the next crop of 

leaders. 

“There’s a war for talent on a global 

basis,” said Gareth El Mettouri, associate 

director at Robert Half UAE, a human 

resource consulting organisation.

In order to compete, an increasing 

number of companies are setting up 

“talent factories”, which Doug Ready, a 

senior lecturer at the MIT Sloan School of 

Management, de�nes as pipelines of 

high-potential employees that “marry 

functionality, or rigorous talent processes 

that support strategic and cultural 

objectives, and vitality, meaning 

emotional commitment from 

management that is re�ected in daily 

actions”.

These pipelines can help ensure a 

steady supply of talented individuals are 

ready to �ll leadership roles, but even 

when the talent you are looking for is 

already in-house, you still have to know 

how to spot them. That can be challenging 

because the most desirable qualities of 

future leaders are constantly shifting and 

becoming increasingly elusive. 

A
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As Claudio Fernández-Aráoz wrote in a 

2014 Harvard Business Review article, 

“21st-Century Talent Spotting”, 

organisations and their leaders must 

transition to a new era in the hunt for 

stars, “one in which our evaluations of 

one another are based not on brawn, 

brains, experience, or competencies, but 

on potential”, which he de�ned as the 

ability to adapt to and grow into 

increasingly complex roles and 

environments. It’s not all about hard skills 

anymore — those skills must be paired 

with experience, soft skills, and fresh 

perspectives.

Finding the �nance leaders of the future 

early has never been more important. A 

wise �nance leader will build an e�ective 

team around them and constantly be 

spotting potential talent. Often, that talent 

is already working for you. Here are four 

things to look out for to identify the rising 

stars on your �nance team:

Catalytic learning capabilities
Rising stars are always learning, and 

because business models are changing 

all the time and new competition is 

always lurking around the corner, 

up-and-coming leaders must be 

comfortable operating in a continuous 

learning mode.

When assessing team members for 

potential leadership possibilities, look for 

employees who voluntarily take on 

additional courses, attend conferences, 

and acquire valuable certi�cates in key 

areas. 

“You need folks who have almost an 

intrinsic sense of curiosity, or what I like 

to call catalytic learning capability,” Ready 

said. “In other words, they’re able to 

absorb a lot, learn from it, and catalyse 

that learning into productive value for 

customers.” These are employees who are 

curious enough to look around for trends, 

are always embracing change, and are 

perennial learners.

Resilience
A high-potential professional is willing to 

try new things and is resourceful when 

placed in unfamiliar situations. The great 

ones are those who, even when they run 

into a roadblock, consider that roadblock 

temporary and pivot to the future, 

according to Ready. Look for team 

members who display creative  

problem-solving and are relentless in 

their pursuit of trying to improve things 

for both the customer and the company. 

“The high potentials are the ones who 

want to see that direct linkage between 

their contributions and productive 

outcomes,” Ready said. “They want clarity 

about what the big challenges facing their 

company are and how they can help.”

Rising stars are also extremely 

interested in feedback — praise as well as 

developmental feedback that can help 

them get better. When looking for rising 

stars, watch for resilient individuals who 

seek out feedback and can take criticism 

and use it to improve their performance. 

Data and tech skills
Advances in technology are changing the 

nature of opportunities available in 

�nance, according to James Brent, a 

UK-based senior business director at 

Hays, a global recruiting company. You 

should be looking for individuals who 

embrace this change and adapt to new 

innovations in the market. 

“There is increased appetite for 

accountants and �nance professionals 

who can also work as business analysts 

and data scientists and use their 

technology skills to their advantage to 

further their career,” he said. 

Individuals with a background in 

analysis or data science, or those who are 

eager to learn those �elds, are likely 

candidates for leadership. 

“A leader needs to have, at a 

minimum, a deep appreciation for the 

power of analytics in order to drive a 

strategy that’s based on analytics,” Ready 

said. “It means understanding the power 

of analytics, big data, and the practical 

applications of arti�cial intelligence and 

machine learning. You can’t just relegate 

that to young people down at the bottom 

of the hierarchy.”

Diverse perspectives
It is vital to ensure that your company is 

developing a talent pipeline that re�ects 

your customer base, and if your current 

leadership only represents one subset of 

the population, you should be looking 

for talent with new and di�erent 

perspectives that can help keep your 

company in touch with the modern era 

and maintain a fresh wellspring of ideas. 

Diverse talent with experience in a 

variety of work environments across 

both global cultures and company 

functions are likely candidates for 

leadership. 

There is a lot of consolidation 

happening, El Mettouri said, and 

candidates who have experience working 

in a variety of environments are better 

prepared to �nd solutions that work well 

in speci�c contexts. 

You should be looking for talented 

individuals who have already taken, or 

are willing to take, work assignments in 

foreign countries, as well as individuals 

who have a lifetime of experience as an 

underrepresented minority in the �eld. 

“If your business is globalising and 

your customers are increasingly diverse, 

you had better have people in your 

organisation that are increasingly diverse 

so they at least have a better chance of 

understanding customer preferences,” 

Ready said.    Q

‘They want clarity about what the 
big challenges facing their company 
are and how they can help.’
Doug Ready, a senior lecturer at the MIT Sloan School of Management, on high potentials

Hannah Pitstick is a freelance writer 

based in the US. To comment on this 

article or to suggest an idea for another 

article, contact Drew Adamek, an  

FM magazine senior editor, at  

Andrew.Adamek@aicpa-cima.com.  
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KHWKHU�LW·V�D�ODVW�PLQXWH�LQWHUQDWLRQDO�WULS�

WR�ÀQDOLVH�D�GHDO��GLQQHUV�DW�XSPDUNHW�

VWHDNKRXVHV�IRU�OR\DO�FOLHQWV��RU�KRWHO�

URRPV�IRU�D�SURIHVVLRQDO�FRQIHUHQFH��

WUDYHO�DQG�UHODWHG�FRVWV�FDQ�WDNH�XS�D�

KHDOWK\�FKXQN�RI�D�FRPSDQ\·V�ERWWRP�OLQH��

:LWK�LQFUHDVLQJ�QXPEHUV�RI�UHPRWH�ZRUNHUV�DQG�

D�JOREDO�EXVLQHVV�HQYLURQPHQW��EXVLQHVV�WUDYHO�LV�D�

IRUHJRQH�FRQFOXVLRQ��HYHQ�DV�WHFKQRORJLHV�KDYH�PDGH�

YLUWXDO�PHHWLQJV�DQG�LQWHUDFWLRQ�EHWZHHQ�IDU�ÁXQJ�

DVVRFLDWHV�HDV\��&RPSDQLHV�FDQ�EHQHÀW�E\�VFUXWLQLVLQJ�

WKHLU�WUDYHO�H[SHQVH�SURFHVV�DQG�ÀQGLQJ�ZD\V�WR�HQVXUH�

WKH\·UH�JHWWLQJ�WKH�EHVW�SULFHV�DQG�DQWLFLSDWLQJ�IXWXUH�

FRVWV�ZKLOH�GLVFRXUDJLQJ�HPSOR\HHV�IURP�WDNLQJ�XQIDLU�

DGYDQWDJH�RI�WUDYHO�UHLPEXUVHPHQW�SROLFLHV��H[SHUWV�VD\��

2XWVLGH�WUDYHO�PDQDJHPHQW�JURXSV�RU�HPSRZHUHG� 

LQ�KRXVH�ÀQDQFH�WHDPV�FDQ�ZRUN�WR�QHJRWLDWH�VSHFLDO�

UDWHV�ZLWK�DLUOLQHV��KRWHO�FKDLQV��FDU�UHQWDO�ÀUPV��DQG�

PRUH��VDLG�:LOO�7DWH��&3$��D�SDUWQHU�DQG�EXVLQHVV�

SURFHVV�H[SHUW�DW�*ROG6SULQJ�&RQVXOWLQJ�RXWVLGH�RI�

'DOODV��ZKLFK�DVVLVWV�FRUSRUDWLRQV�LQ�HYDOXDWLQJ�DQG�

PDQDJLQJ�WKHLU�WUDYHO�H[SHQVHV��$�ZHOO�PDQDJHG�

FRUSRUDWH�WUDYHO�SURJUDPPH�FRXOG�UHVXOW�LQ�XS�WR�����

VDYLQJV�ZLWKLQ�D�\HDU�RU�WZR�RI�LPSOHPHQWDWLRQ��7DWH�

HVWLPDWHV��HVSHFLDOO\�IRU�FRPSDQLHV�WKDW�VSHQG����PLOOLRQ�

D�\HDU�RU�PRUH�RQ�WUDYHO��

´,W·V�JRRG�PRQH\�µ�KH�VDLG��DERXW�WKH�SRWHQWLDO�VDYLQJV��

7KRVH�VDYLQJV�DUH�DFKLHYHG�LQ�ODUJH�SDUW�E\�GHHS�

DQDO\VLV�RI�SDVW�WULSV�DQG�LQWHQWLRQDO�HIIRUWV��HLWKHU�ZLWK�

FRQVXOWDQWV�RU�WKURXJK�LQ�KRXVH�UHYLHZV��WR�DGMXVW�WUDYHO�

EHKDYLRXUV�RI�HPSOR\HHV�WR�ZKLWWOH�GRZQ�FRVWV��KH�VDLG��

$GMXVWLQJ�EHKDYLRXUV�FRXOG�LQYROYH�SROLFLHV�WKDW�SUHVHUYH�

WKH�FRPIRUW�DQG�HDVH�RI�WUDYHO�ZKLOH�LQFHQWLYLVLQJ�ORZHU�

SULFHV��

COST NOT SOLE FOCUS

:KLOH�FRVW�VDYLQJV�DUH�VWLOO�D�WRS�SULRULW\�IRU�PRVW�

SURFXUHPHQW�RIÀFHV��LW·V�QRW�WKH�RQO\�FRQVLGHUDWLRQ��

DFFRUGLQJ�WR�DQ�DQDO\VLV�RI�FRUSRUDWH�WUDYHO�WUHQGV�E\�

3KRFXVZULJKW��D�GDWD�DQG�DQDO\VLV�FRPSDQ\�IRU�WKH�WUDYHO�

DQG�KRVSLWDOLW\�LQGXVWU\�

$�UHFHQW�IRUZDUG�ORRNLQJ�UHSRUW�RQ�WUHQGV�LQ�86�

FRUSRUDWH�WUDYHO�IRXQG�����RI�WUDYHO�PDQDJHUV�OLVWHG�

FRVW�DV�D�WRS�VWUDWHJLF�SULRULW\��ZKLOH�����VDZ�WKH�

ZHOOEHLQJ�DQG�VDWLVIDFWLRQ�RI�WUDYHOOLQJ�VWDII�DV�D�PDMRU�

JRDO��2WKHU�WRS�JRDOV�ZHUH�NHHSLQJ�WUDYHOOLQJ�HPSOR\HHV�

VDIH��HQKDQFLQJ�GDWD�FDSDELOLWLHV��DQG�LPSURYLQJ�SROLF\�

FRPSOLDQFH��

7DWH�VDLG�FRPSDQLHV�QHHG�WR�EH�FOHDU�DERXW�WKHLU�

SULRULWLHV�ZKHQ�VHHNLQJ�RXW�WKLUG�SDUWLHV�WR�PDQDJH�WUDYHO�

SURJUDPPHV��,I�D�QHZ�WUDYHO�DJHQF\�ÀQGV�VLJQLÀFDQW�

VDYLQJV�ZLWK�FKHDSHU�ÁLJKWV�EXW�HPSOR\HH�PRUDOH�LV�

KDUPHG�E\�ERRNHG�ÁLJKWV�WKDW�OHDYH�DW�LQFRQYHQLHQW�

WLPHV�ZLWK�PXOWLSOH�WUDQVIHUV��DQ\�VDYLQJV�PD\�EH�RIIVHW�

E\�WKH�GUDLQ�RQ�VWDII��KH�VDLG���)RU�D�GLVFXVVLRQ�RI�KRZ�

RUJDQLVDWLRQV�FDQ�EDODQFH�VRXQG�SROLFLHV�ZLWK�HPSOR\HH�

ZHOOEHLQJ��VHH�WKH�VLGHEDU��´0L[LQJ�5XOHV�:LWK�&KRLFHV�

0D\�%H�WKH�%HVW�7UDYHO�3ROLF\µ��

0RVW�FRPSDQLHV�DOUHDG\�KDYH�D�ZHDOWK�RI�LQIRUPDWLRQ�

DW�WKHLU�GLVSRVDO��ZLWK�SDVW�WULSV�RIIHULQJ�LQVLJKW�LQWR�

DYHUDJH�WULS�FRVWV��UHVWDXUDQWV�RU�DLUOLQHV�IUHTXHQWHG��

DQG�PRUH��%\�FRQVROLGDWLQJ�GDWD�DFURVV�D�FRPSDQ\�

RU�GLYLVLRQ��WUDYHO�EX\HUV�FDQ�JHW�LQVLJKWV�LQWR�WKRVH�

H[SHQVHV�DQG�LGHQWLI\�SODFHV�IRU�VDYLQJV��7DWH�VDLG��

'DWD�DQDO\VLV�FDQ�WKHQ�EH�XVHG�LQ�ELGV�ZLWK�SURYLGHUV�WR�

QHJRWLDWH�EHWWHU�UDWHV�DQG�DOORZ�H[HFXWLYHV�WR�DGGUHVV�

DEHUUDWLRQV��)RU�H[DPSOH��D�FORVH�ORRN�DW�SDUNLQJ�FRVWV�

FRXOG�VKRZ�HPSOR\HHV�H[SHQVLQJ�SUHPLXP�DPRXQWV�WR�

SDUN�LQ�FDU�SDUNV�FORVHVW�WR�WKH�DLUSRUW�IRU�ZHHNORQJ�WULSV�

DQG�SURPSW�D�SROLF\�FKDQJH�WR�HQFRXUDJH�WKH�XVH�RI�

UHPRWH�FDU�SDUNV�RU�SDUN�DQG�ULGH�VHUYLFHV��

FRAUD A FOCUS

)RU�WKRVH�WDVNHG�ZLWK�PRQLWRULQJ�FRPSDQ\�WUDYHO�

SURJUDPPHV��WKHUH·V�DOVR�D�QHHG�WR�VHW�XS�SROLFLHV�

DQG�LQWHUQDO�FRQWUROV�WR�GLVFRXUDJH�IUDXGXOHQW�

UHLPEXUVHPHQWV��VDLG�&HFLOLD�/RFDWL��)&0$��&*0$��

RZQHU�RI�WKH�FRQVXOWLQJ�ÀUPV�,QWHUQDO�&RQWURO�7RROER[�

DQG�)UDXG�)HQFH��7KDW�LQFOXGHV�FRQGXFWLQJ�UHJXODU�

DXGLWV��ZKLFK�QRW�RQO\�FDQ�GHWHFW�SUREOHPDWLF�H[SHQVHV�

EXW�DOVR�FDQ�VHUYH�DV�D�SUHYHQWLYH�PHDVXUH��.QRZOHGJH�

WKDW�H[SHQVHV�ZLOO�EH�VFUXWLQLVHG�LV�RIWHQ�HQRXJK�WR�GHWHU�

IUDXGXOHQW�EHKDYLRXU��/RFDWL�VDLG��

,QWHUQDO�DXGLWV�´FDQ�EH�YHU\�HIIHFWLYH�LI�>FRPSDQLHV@�

KDYH�DOO�WKH�GDWD�LQ�WKH�VRIWZDUHµ��VDLG�/RFDWL��ZKR�

KDV�ZRUNHG�ZLWK�FRPSDQLHV�DURXQG�WKH�JOREH�WR�

VWUXFWXUH�EXVLQHVV�WUDYHO�SURJUDPPHV��ZLWK�D�IRFXV�RQ�

GLVFRXUDJLQJ�HPSOR\HH�IUDXG��

([SHQVH�UHLPEXUVHPHQW�VFKHPHV�UHPDLQ�D�VLJQLÀFDQW�

SHUFHQWDJH�RI�RFFXSDWLRQ�UHODWHG�IUDXG�ZRUOGZLGH��

PDNLQJ�XS�����RI�WKH�QHDUO\�������IUDXGXOHQW�FDVHV�

H[DPLQHG�IRU�D������UHSRUW�RQ�RFFXSDWLRQDO�IUDXG�E\�WKH�

$VVRFLDWLRQ�RI�&HUWLÀHG�)UDXG�([DPLQHUV��$&)(��

1RU�LV�WKH�FRVW�RI�WKRVH�PLVGHHGV�LQVLJQLÀFDQW��ZLWK�DQ�

DYHUDJH�UHSRUWHG�ORVV�RI���������IRU�LVVXHV�WKDW�ODVWHG�DQ�

DYHUDJH�RI�WZR�\HDUV�EHIRUH�GHWHFWLRQ��DFFRUGLQJ�WR�WKH�

$&)(�UHSRUW�

7KH�LQGXVWULHV�PRVW�OLNHO\�WR�H[SHULHQFH�WKLV�W\SH�RI�

IUDXG�ZHUH�FKDULWDEOH�DQG�UHOLJLRXV�RUJDQLVDWLRQV�DQG�WKH�

SURIHVVLRQDO�VHUYLFHV�LQGXVWU\��ZKLOH�WKH�EDQNLQJ�LQGXVWU\�

VDZ�WKH�ORZHVW�UDWHV��DFFRUGLQJ�WR�WKH�$&)(�UHSRUW��

7KDW·V�OLNHO\�EHFDXVH�QRQJRYHUQPHQWDO�RUJDQLVDWLRQV�

DQG�FKDULWLHV�PD\�KDYH�ZHDNHU�LQWHUQDO�FRQWUROV��

ZKLOH�EXVLQHVVHV�LQ�WKH�FORVHO\�UHJXODWHG�EDQNLQJ�
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LQGXVWU\�WHQG�WR�KDYH�VWULFW�SURFHVVHV�WKURXJKRXW�WKHLU�

RUJDQLVDWLRQV��/RFDWL�VDLG��6KH�VDLG�IUDXG�LV�FRPPRQ�DW�

RUJDQLVDWLRQV�ZLWK�SRRU�LQWHUQDO�FRQWUROV�DV�ZHOO�DV�WKRVH�

ZKHUH�DQWL�IUDXG�SROLFLHV�DUH�QRW�LQ�SODFH��HQIRUFHG��RU�

FRPPXQLFDWHG�

,QWHUHVWLQJO\��VPDOOHU�FRPSDQLHV�³�WKRVH�ZLWK�IHZHU�

WKDQ�����HPSOR\HHV�³�ZHUH�OLNHO\�WR�KDYH�PRUH�LVVXHV�

ZKHQ�LW�FRPHV�WR�H[SHQVHV�IUDXG��WKH�VWXG\�IRXQG��

/DUJHU�FRPSDQLHV��VKH�VDLG��DUH�PRUH�OLNHO\�WR�LQYHVW�LQ�

VRIWZDUH�WR�PRQLWRU�H[SHQVHV�DQG�KDYH�FOHDU�SROLFLHV�VR�

HPSOR\HHV�NQRZ�ZKDW�LV�DQG�LVQ·W�DOORZHG��

:LWK�SOHQW\�RI�PRQH\��DQG�ULVN��RQ�WKH�OLQH��KHUH�DUH�

DGGLWLRQDO�WLSV�RQ�KRZ�WR�EHVW�PDQDJH�DQG�PRQLWRU�D�

FRUSRUDWH�WUDYHO�SROLF\��

Hammer out a policy

+DYLQJ�D�FOHDU�FRUSRUDWH�SROLF\�VWDWLQJ�KRZ�HPSOR\HHV�

VKRXOG�ERRN�ZRUN�UHODWHG�WUDYHO�³�ZKHWKHU�RQ�WKHLU�

RZQ�RU�WKURXJK�DQ�DSSURYHG�EXVLQHVV�WUDYHO�SODWIRUP�

³�DQG�VHHN�UHLPEXUVHPHQW�FDQ�KHOS�FRPSDQLHV�UHLQ�LQ�

H[RUELWDQW�FRVWV��/RFDWL�VDLG��6KH�VXJJHVWV�NHHSLQJ�DQ\�

SROLFLHV�WR�D�IHZ�SDJHV�WR�LQFUHDVH�FRPSOLDQFH�DPRQJ�

VWDII��´7KH�ORQJHU�WKH\�DUH��WKH�OHVV�WKH\�DUH�UHDG�µ�VKH�

VDLG��&RQVLGHUDWLRQV�WR�LQFOXGH�DUH�ZKHWKHU�WR�UHTXLUH�

SUH�DSSURYDOV�IRU�WULSV�WKDW�H[FHHG�D�FHUWDLQ�SULFH��

JXLGDQFH�RQ�KRZ�FRUSRUDWH�FUHGLW�FDUGV�FDQ�EH�XVHG��DQG�

ZKHWKHU�HPSOR\HHV�FDQ�H[SHQVH�WKLQJV�OLNH�DOFRKRO�RU�

HQWHUWDLQPHQW�FRVWV��)RU�ÁLJKW�ERRNLQJV��LQGLFDWH�ZKHQ�RU�

LI�EXVLQHVV�FODVV�WLFNHWV�DUH�DSSURSULDWH�DQG�LI�HPSOR\HHV�

QHHG�WR�ERRN�WKH�FKHDSHVW�ÁLJKWV�DYDLODEOH��RU�LI�WKHUH�LV�

ÁH[LELOLW\�WR�RSW�IRU�SULFLHU�ÁLJKWV�LI�WKHUH�DUH�IHZHU�OHJV�RU�

PRUH�FRQYHQLHQW�GHSDUWXUH�WLPHV��

Drill down for details

:KHQ�LW�FRPHV�WR�RXW�RI�RIÀFH�H[SHQVHV��LW·V�LPSRUWDQW�

WR�EH�FOHDU�DERXW�ZKDW�WKH�FRPSDQ\�ZLOO�DQG�ZRQ·W�FRYHU��

/RFDWL�VDLG��&RPSDQLHV�WKDW�GR�KDYH�UHVWULFWLRQV�RQ�

FHUWDLQ�SXUFKDVHV�VKRXOG�PDNH�VXUH�H[SHFWDWLRQV�DUH�

FOHDU�DQG�WKHQ�H[DPLQH�LWHPLVHG�ELOOV�RI�KRWHO�FKDUJHV��

6RPH�PD\�WU\�WR�VOLS�LQ�H[SHQVHV�³�OLNH�WKH�H[SHQVLYH�

VQDFNV�RU�GULQNV�LQ�WKH�PLQL�EDU�³�DQG�UHTXLULQJ�LWHPLVHG�

ELOOV�ZLOO�OLNHO\�GLVFRXUDJH�DQ\�H[WUDQHRXV�H[SHQVHV��´,W·V�

XS�WR�WKH�FRPSDQ\�WR�GHFLGH�KRZ�PDQ\�EHQHÀWV�WKH\�

ZDQW�WR�JLYH�WR�WKH�HPSOR\HHV�µ�VKH�VDLG��

Consider per diems

6RPH�HPSOR\HUV�FKRRVH�WR�VNLS�WKH�KHDGDFKHV�RI�

UHTXLULQJ�UHFHLSWV�WR�SURYH�SXUFKDVHV�DQG�LQVWHDG�RSW�

IRU�SHU�GLHP�DOORZDQFHV�RU�KDYH�SHU�GLHP�OLPLWV�EDVHG�

RQ�ORFDWLRQ��%\�KDYLQJ�D�VHW�UDWH�IRU�PHDOV�RU�RWKHU�

H[SHQVHV��LW�FDQ�DOORZ�WUDYHO�PDQDJHUV�WR�SUHGLFW�ZHOO�

DKHDG�RI�WLPH�KRZ�PXFK�WKH\·OO�EH�VSHQGLQJ�RQ�WUDYHO��

SPONSORED REPORT

6RPH�ODUJH�FRPSDQLHV�KDYH�FDOFXODWHG�ZKDW�DQ�DYHUDJH�

FRVW�PD\�EH�IRU�D�EXVLQHVV�WULS�WR�D�SDUWLFXODU�FLW\��VD\�

�������IRU�WKUHH�GD\V�LQ�:DVKLQJWRQ��DQG�WKHQ�JLYH�WKH�

HPSOR\HHV�WKDW�DPRXQW�GLUHFWO\�DQG�OHDYH�WKH�GHWDLOV�XS�

WR�WKHP��,W�FDQ�DOVR�EH�D�ERRVW�IRU�HPSOR\HHV��OHDYLQJ�

WKHP�WKH�RSWLRQ�RI�FKRRVLQJ�ZKHWKHU�WR�VSHQG�WKHLU�ZKROH�

SHU�GLHP��RU�WR�HDW�RQ�WKH�FKHDS�DQG�SRFNHW�WKH�UHVW��

/RFDWL�VDLG��,W�PD\�QRW�QHFHVVDULO\�PHDQ�D�VDYLQJV��EXW�

KDYLQJ�WRS�SHUIRUPHUV�IHHO�FRQWHQW�FDQ�JR�D�ORQJ�ZD\��

Separate pleasure and business

7KHUH·V�DQ�XSWLFN�LQ�WKH�WUDYHO�LQGXVWU\�RI�ZKDW·V�NQRZQ�

DV�´EOHLVXUH�µ�D�EOHQGLQJ�RI�ZRUN�UHODWHG�DQG�SHUVRQDO�

WUDYHO�ZKHUH�WUDYHOOLQJ�VDOHV�SHRSOH�RU�RWKHUV�WDFN�RQ�D�

IHZ�GD\V�WR�VSHQG�D�ZHHNHQG�LQ�DQ�DWWUDFWLYH�ORFDWLRQ��

,W·V�LPSRUWDQW�WR�EH�FOHDU�DERXW�KRZ�WR�KDQGOH�WKRVH�W\SHV�

RI�DUUDQJHPHQWV��VDLG�'DYLG�$QGHUVRQ��&3$��ZKR�KHDGV�

D�IRUHQVLF�DFFRXQWLQJ�ÀUP�LQ�3KLODGHOSKLD��$QGHUVRQ��

ZKR�JHQHUDOO\�DGYLVHV�DJDLQVW�PL[LQJ�SURIHVVLRQDO�DQG�

SHUVRQDO�WUDYHO��JDYH�WKH�H[DPSOH�RI�DQ�H[HFXWLYH�ZKR�

JDLQHG�SHUPLVVLRQ�WR�EX\�D�VSRXVH�D�SODQH�WLFNHW�RQ�D�

FRUSRUDWH�FDUG�ZLWK�WKH�SURPLVH�RI�SD\LQJ�WKH�FRPSDQ\�

EDFN��6XFK�DQ�DJUHHPHQW�UHTXLUHV�VRPHRQH�WR�PDNH�

VXUH�WKH�PRQH\�LV�SDLG�EDFN�DQG�DFFRXQWHG�IRU�FRUUHFWO\��

+DYLQJ�FOHDU�SROLFLHV�WKDW�DGGUHVV�KRZ�FRVWV�ZLOO�EH�

Mixing rules with choices may 
be the best travel policy

W
KLOH�D�ZHOO�FRQVWUXFWHG�WUDYHO�DQG�H[SHQVH�

SROLF\�ZLOO�KROG�HYHU\RQH�DFFRXQWDEOH�WR�

WKH�VDPH�VHW�RI�UXOHV��SURYLGLQJ�VRPH�OHYHO�RI�

ÁH[LELOLW\�WR�DFFRPPRGDWH�SHUVRQDO�WDVWHV�FDQ�OHDG�

HPSOR\HHV�WR�EH�PRUH�VDWLVÀHG�

7KH�DYDLODELOLW\�RI�FKRLFHV�ZDV�D�NH\�IDFWRU�

LQ�WUDYHOOHU�VDWLVIDFWLRQ�LQ�D������VXUYH\�RI�

������IUHTXHQW�EXVLQHVV�WUDYHOOHUV�LQ�$XVWUDOLD��

&DQDGD��WKH�8.��DQG�WKH�86�FRQGXFWHG�E\�LQYRLFH�

DXWRPDWLRQ�VXSSOLHU�&KURPH�5LYHU��$PRQJ�WUDYHOOHUV�

ZKR�LGHQWLÀHG�WKHPVHOYHV�DV�´YHU\�VDWLVÀHGµ�

�Q �����ZHUH�SHUPLWWHG�WR�WUDYHO�RQ�WKH�DLUOLQH�RI�

WKHLU�FKRLFH�

�Q �����ZHUH�DOORZHG�WR�FKRRVH�WKHLU�KRWHO�

�Q �����VDLG�WKH\�FRXOG�VHOHFW�WKHLU�FDU�UHQWDO�ÀUP�

6R��ZKLOH�D�SROLF\�WKDW�KROGV�HYHU\RQH�DFFRXQWDEOH�

PLJKW�UHTXLUH�WKDW�DOO�HPSOR\HHV�Á\�LQ�HFRQRP\�UDWKHU�

WKDQ�LQ�EXVLQHVV�FODVV��DOORZLQJ�WUDYHOOHUV�WR�SLFN�WKHLU�

RZQ�DLUOLQH��ZLWKLQ�UHDVRQ��GHSHQGLQJ�RQ�IDUHV��PLJKW�

FRQWULEXWH�WR�HPSOR\HH�VDWLVIDFWLRQ�
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SPONSORED REPORT

KDQGOHG�LI�DQ�DVVRFLDWH�WDFNV�RQ�D�IHZ�SHUVRQDO�GD\V�ZLOO�

JR�D�ORQJ�ZD\�WRZDUGV�DVVXULQJ�WKH�FRPSDQ\�LVQ·W�SD\LQJ�

IRU�VRPHRQH·V�EHDFKVLGH�YLOOD�VWD\��

Avoid exceptions

2QFH�\RX·YH�JRW�WKDW�SROLF\�LQ�SODFH��IROORZ�LW��7RR�PDQ\�

FRPSDQLHV�ÀQG�WKHPVHOYHV�LQ�WURXEOH�ZKHQ�WKH\�JLYH�

RQH�VWDIIHU�UHVSLWH�IURP�WKH�SROLF\�DQG�ÀQG�WKDW�HLWKHU�

WKDW�SHUVRQ�RU�RWKHU�VWDII�KDYH�FRQWLQXHG�WR�GHYLDWH�

IURP�WKH�FRPSDQ\·V�UXOHV��$QGHUVRQ�VDLG��+H�JDYH�

WKH�H[DPSOH�RI�D�UHJLRQDO�PDQDJHU�JHWWLQJ�SHUPLVVLRQ�

WR�Á\�EXVLQHVV�FODVV�GHVSLWH�D�UXOH�DJDLQVW�LW��2IWHQ��

WKDW�PDQDJHU·V�FRKRUWV�ZLOO�EHJLQ�VHHNLQJ�WKH�VDPH�

DOORZDQFHV��´$V�VRRQ�DV�\RX�KDYH�VRPHRQH�JUDQWHG�DQ�

H[FHSWLRQ�WR�VRPH�NLQG�RI�UXOH��VRPHKRZ�HYHU\RQH�HOVH�

ÀQGV�RXW�DERXW�WKDW�DQG�VWDUWV�WDNLQJ�DGYDQWDJH�RI�WKLV�

UXOH�µ�$QGHUVRQ�VDLG��:KLOH�WKHUH�ZLOO��RI�FRXUVH��EH�YDOLG�

H[FHSWLRQV�WR�DQ\�UXOH��PDNH�VXUH�DQ\�GHYLDWLRQ�IURP�

SROLF\�LV�ZHOO�GRFXPHQWHG�DQG�KDV�JRQH�WKURXJK�WKH�

SURSHU�FKDQQHOV�IRU�DSSURYDO��

Set the tone up top

2QH�RI�WKH�PRVW�LPSRUWDQW�WKLQJV�FRPSDQ\�H[HFXWLYHV�

FDQ�GR�WR�HQVXUH�FRPSOLDQFH�ZLWK�WUDYHO�DQG�H[SHQVH�

UXOHV�LV�WR�VHW�WKH�H[SHFWDWLRQ�WKDW�SROLFLHV�EH�IROORZHG��

´,I�WKH\�GRQ·W�FDUH��WKHUH�LV�QR�SROLF\�RU�LQWHUQDO�FRQWURO�

WKDW�ZRXOG�SUHYHQW�IUDXG�µ�/RFDWL�VDLG��7KDW�PHDQV�LI�WRS�

PDQDJHUV�DUH�UHTXLUHG�WR�KDYH�WKHLU�H[SHQVHV�DSSURYHG��

PDNH�VXUH�WKDW�KDSSHQV�WR�WKHP�LQ�WKH�VDPH�PDQQHU�

DV�IRU�WKRVH�ORZHU�GRZQ�LQ�WKH�RUJDQLVDWLRQ��&RUSRUDWH�

ERDUGV�FDQ�DOVR�JHW�LQYROYHG�E\�UHJXODUO\�UHYLHZLQJ�WKH�

H[SHQVH�DFFRXQWV�RI�&(2V�DQG�RWKHU�WRS�OHDGHUV��

Have ways to report violations

,W·V�LPSRUWDQW�WR�KDYH�D�ZHOO�DGYHUWLVHG�DYHQXH�WR�UHSRUW�

GHYLDWLRQV�IURP�SROLF\��/RFDWL�VDLG��7KDW�PD\�RFFXU�

WKURXJK�DQRQ\PRXV�KRWOLQHV�HPSOR\HHV�FDQ�FDOO�WR�SDVV�

RQ�WLSV�WR�H[SHULHQFHG�WKLUG�SDUW\�JURXSV��RU�DQ�LQ�KRXVH�

V\VWHP�WR�JDWKHU�FRQFHUQV�DERXW�VXVSLFLRQ�RI�IUDXGXOHQW�

EHKDYLRXU��)RU�H[DPSOH��WKHUH�PD\�EH�D�ZLGHVSUHDG�

SUDFWLFH�LQ�D�UHJLRQDO�RIÀFH�WR�SDG�H[SHQVH�UHSRUWV�WKDW�

JRHV�XQQRWLFHG�DW�KHDGTXDUWHUV�XQWLO�D�YDOLG�WLS�FRPHV�

LQ�WR�FRUSRUDWH�RIÀFLDOV��´6RPHWLPHV�LQ�FRPSDQLHV��

HYHU\ERG\�NQRZV�EXW�QRERG\�VD\V�DQ\WKLQJ�µ�/RFDWL�VDLG��

FINDING TRAVEL SUPPLIERS

0DQ\�IDFWRUV�PXVW�EH�WDNHQ�LQWR�DFFRXQW�ZKHQ�FKRRVLQJ�

D�WUDYHO�PDQDJHPHQW�FRPSDQ\�RU�D�SDUWLFXODU�YHQGRU��

7DWH�VDLG��$QG�WKHUH·V�QR�VKRUWDJH�RI�RSWLRQV�IRU�WKRVH�

LQ�WKH�PDUNHW��+H�VXJJHVWHG�WKRVH�PDNLQJ�WKH�GHFLVLRQ�

KDYH�D�VWURQJ�XQGHUVWDQGLQJ�RI�ZKDW�WKH\�ZDQW��,W·V�

OLNHO\�QRW�MXVW�VDYLQJV��DQG�WKHUH·V�DQ�LPSRUWDQW�EDODQFH�

EHWZHHQ�HQVXULQJ�WUDYHOOLQJ�HPSOR\HHV�DUH�FRPIRUWDEOH�

DQG�DEOH�WR�SHUIRUP�DW�WKHLU�EHVW�DQG�ÀQGLQJ�WKH�ORZHVW�

FRVW�RSWLRQV��,W�KHOSV�WR�JR�LQ�NQRZLQJ�ZKDW�\RXU�RZQ�

WUHQGV�DUH�³�ZKDW�DLUOLQHV�JHW�PRVW�RI�\RXU�PRQH\��

ZKDW�UHVWDXUDQWV�DUH�IUHTXHQWHG�E\�VWDII�IRU�ZRUN�UHODWHG�

PHDOV��DQG�ZKDW�SDUWLFXODU�QHHGV�\RXU�VWDII�KDV��

,W�PD\�QRW�PDNH�VHQVH�WR�IRUFH�D�WRS�VDOHV�SHUVRQ�

WR�VLW�LQ�DQ�HFRQRP\�VHDW�IRU�D�ORQJ�LQWHUQDWLRQDO�WULS�

ZKHUH�VKH·OO�EH�PHHWLQJ�ZLWK�LPSRUWDQW�FOLHQWV�VRRQ�DIWHU�

ODQGLQJ��,QVWHDG��WKH�H[WUD�FRVW�RI�SXWWLQJ�KHU�LQ�EXVLQHVV�

FODVV�VR�VKH�FDQ�JHW�QHHGHG�UHVW�RU�ZRUN�XQHQFXPEHUHG�

PD\�EHWWHU�ÀW�WKH�FRPSDQ\·V�QHHGV��´<RX�QHJRWLDWH�WR�JHW�

WKH�EHVW�KLW�µ�KH�VDLG����Q
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The barriers to enhanced risk oversight 

B
y several measures, enterprise risk management (ERM) is 

more understood and more valued today than it was ten 

years ago. Yet, robust risk management remains elusive for 

many entities.

The State of Risk Oversight (available at tinyurl.com/y2bwldgz), 

an annual survey of business leaders by North Carolina State 

University and the AICPA, is ten years old, so trends can be 

analysed. The most recent survey drew responses from nearly 450 

CFOs or equivalent senior executives in business and industry in 

the US. The data come from industries of all sizes — 16% of 

respondents’ organisations had annual revenue of less than $10 

million, and 14% had annual revenue greater than $10 billion.

In general, larger companies and publicly traded ones have a 

more formal risk function. But much work remains to be done.

“While there is some indication that management e�orts 

related to enterprise-wide risk oversight are increasing over 

time, there continues to be noticeable room for improving how 

organisations identify, manage, and keep their eyes on risks that 

may emerge and signi�cantly impact their ability to achieve 

strategic goals,” the report said.

Here are several key themes from the report that 

organisations should consider when designing, strengthening, 

or elevating the importance of ERM practices:

yyy The management of risks is not getting easier. Nearly 

60% said the volume and complexity of risks have increased 

mostly or extensively over the past five years. As risks 

emerge and digital-born competitors rise, organisations 

admit they are sometimes caught o�-guard by the 

fast-moving business environment, changing regulations, 

and political challenges. Ten years ago, as the Great 

Recession was ending, the percentage was similar (62%).

yyy External stakeholders seek more engagement in risk 

management from senior executives. This trend goes 

beyond the very real scenario where activist investors 

push for changes to a public company’s board of directors 

or its strategy, as happened earlier this year to Bed Bath & 

Beyond. An investor group nominated new directors for 

the US retail chain, called out the company for “excessive 

executive compensation” and “repeatedly failed execution 

and strategy”, and pointed out lengthy board tenures. 

According to the report, even a majority of not-for-pro�t 

organisation respondents (57%) said that external parties 

were applying pressure on senior executives for more 

information about risks. In larger companies, that number 

was 75%, and it was 59% for the full sample.

yyy More risk information is 

prepared for executives 

and board members, 

but the reporting 

process remains 

informal. While 

35% say their risk 

oversight processes 

are systematic and 

repeatable with 

regular board-level 

reporting of top risk 

exposures, the rest 

have ad hoc, siloed, 

or unstructured processes 

for board reporting.

yyy Strategies are needed to circumvent barriers that 

inhibit risk management progress. The report 

identified several key impediments to strengthening 

the organisational approach to risk oversight. The 

most common responses: 

· “Risks are monitored in other ways besides ERM”, 

51%

· “Too many pressing needs”, 34%

· “No requests to change our risk management 

approach”, 33%

· “No one to lead the e�ort”, 26%

· “Do not see bene�ts exceeding costs”, 22%

The nature of the barriers to ERM success, the report 

says, have changed little over the past ten years. But the 

nature and velocity of risks have changed. For instance, 

Airbnb began in the summer of 2008, and Uber was 

founded in March 2009. Those businesses are now 

entrenched, and competitors looking to disrupt other 

sectors are sprouting every day. It’s why large companies 

(52%) and public companies (50%) are more concerned than 

others about innovations that might disrupt the 

organisation’s core business model.

It’s also why risk management must be better integrated 

with strategy. Just 40% of current respondents said that 

existing risk exposures were considered mostly or 

extensively when evaluating possible new strategic 

initiatives, compared with 48% in 2009.  

— By Neil Amato (Neil.Amato@aicpa-cima.com), 

an FM magazine senior editor.
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hree-dimensional printing holds promise 

for a manufacturing industry that will 

operate “on demand” and reduce the need 

for warehouses and distribution centres to 

store and ship parts. This is because 3D 

printing can print the whole product instead of the 

alternative of producing parts and assembling them.

That said, experts say 3D printing will not replace 

traditional manufacturing in the foreseeable future 

because it’s still more expensive and slower than 

traditional techniques of casting, forging, stamping, 

and moulding that have been used for centuries. The 

opportunity for 3D printing is not in cost savings but in 

production of highly customised products.

In healthcare, 98% of hearing aids worldwide are 

now 3D-printed, according to a report by Wohlers 

Associates, and crafted to fit each user’s unique ear 

shape. In 2017, athletic apparel company adidas started 

selling 3D-printed shoes to elite athletes based on their 

performance data.

— By Alexis See Tho (Alexis.SeeTho@aicpa-cima.com), 

an FM magazine associate editor.

On-demand

customisation

Grecia the toucan, who lost 
most of his upper beak in 
an attack, eats with his new 
3D-printed beak at Zoo 
Ave animal sanctuary in 
Alajuela, Costa Rica.
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